Universal Transaction Gateway® (UTG®)

Using External Devices
Using External Devices

Using EMV External Devices with the Universal Transaction Gateway® (UTG®)

This document is intended for vendors and developers using external devices that support EMV with their POS/PMS systems. Device settings and configurations are discussed in this document. To use EMV devices with Shift4, a UTG is required. It may be necessary to adjust external devices, such as PIN pads, when configuring the UTG or the UTG Stub. For a complete list of supported EMV devices and features, go to www.shift4.com > DOLLARS ON THE NET > INTEGRATIONS > Third-Party Devices.

Configuring Ingenico Telium Retail Base Application (RBA) Devices

If you are using Ingenico Telium RBA device, this section will discuss the following:

- Setting up your device to work with Shift4 and UTG
- Configuration options and settings in UTG
- Collecting information for DOLLARS ON THE NET configuration
- Downloading and modifying Shift4 template forms

Ingenico Telium RBA devices discussed in the section include the following:

- iPP320[US]
- iPP350
- iSC250
- iSC350
- iSC480
- iSMP Companion
- iUP250 / iUR250 / iUC150
- iWL252
- iWL258
- iUP250
Ingenico iPP320 [U.S.]/350 RBA PIN Pad Device Overview

The Ingenico iPP320 [U.S.] and iPP350 offer keypad and multiple card reader functionalities.

**Note:** The iPP320 CAN device is not part of this Telium group and is described with features and settings in the *Ingenico iPP320 CAN* section.

**Important:** Ingenico Telium RBA devices do not support swipe ahead, since swipe ahead is not supported with EMV.

The iPP320 [U.S.]/350 RBA devices are capable of reading card swipes (magnetic stripe) and manual card entry as well as contactless/NFC transactions via an optional contactless card reader module. The iPP320 [U.S.]/350 RBA devices support P2PE, line item display and BIN management. These devices can be connected to UTG via serial, USB, Ethernet or via UTG Stub.

**Requirement:** For Ingenico iPP [US] series PIN pad devices, only version V3 devices can be updated to RBA 16.0.2 or higher for EMV support. Version V2 cannot be updated.

You can determine whether your devices are version V3 by using one of the following methods:

1. Reboot the device.
   - When rebooting, the device screen should display C98, which indicates V3. If the display reads A98, the device is a V2 and cannot be updated.

2. Look on the back of the device for one of the following numbers to indicate the device is V3:
   - For iPP320, look for IPP320-11P2391A
   - For iPP350, look for IPP350-11P1914A

During installation and configuration, the keypad special keys function as follows:

- F3/Arrow Up: scroll up
- F2/Arrow Down: scroll down
- Enter: select highlighted item
- Cancel or Clear: previous screen
Any button enables backlight

Ingenico Touch iSC250/350/480 RBA Signature Capture Device Overview

The Ingenico Touch iSC250, Touch iSC350, and Touch iSC480 RBA devices offer keypad, multiple card reader, signature capture and touch screen functionality. The Touch iSC250/350/480 are capable of reading card swipes (magnetic stripe) and manual card entry as well as contactless/NFC transactions via an optional contactless card reader module. The Touch iSC250/350/480 devices support P2PE, line item display and BIN management. These devices can be connected to UTG via serial, USB, Ethernet or UTG Stub.

During installation and configuration, the keypad special keys function as follows:

- Plus (+): scroll up
- Minus (-): scroll down
- Enter: select highlighted item
- Cancel or Clear: previous screen
- Any button enables backlight
**Ingenico iWL252, iWL258, iCMP & iSMP Companion RBA Mobile Device Overview**

The Ingenico iWL252, iWL258, iCMP (iCM122) iSMP Companion (iMP352) offer keypad and multiple card reader functionalities.

The iWL252, iWL258, iCMP and iSMP Companion mobile RBA devices are capable of reading card swipes (magnetic stripe), manual card entry and contactless/NFC transactions. The iCMP and iSMP Companion support P2PE and BIN management.

The iCMP, and iSMP devices can be connected to UTG via Bluetooth or USB.

The iWL252 device can be connected using any of the following methods:
- UTG via Bluetooth
- USB
- The Ingenico Bluetooth Smart Base (Bluetooth is used to connect to the base station, and a serial or USB cable is used from the Smart Base to the PC on which the UTG is installed).

The iWL258 device can be connected to UTG via Wi-Fi or USB.

---

**Requirement:** For Ingenico iWL series PIN pad devices, only version V3 devices can be updated to RBA 16.0.2 or higher for EMV support. Version V2 cannot be updated.

You can determine whether your devices are version V3 by using one of the following methods:

1. Reboot the device.
   - When rebooting, the device screen should display C98, which indicates V3. If the display reads A98, the device is a V2 and cannot be updated.

2. Look on the back of the device for one of the following numbers to indicate the device is V3:
   - For iWL252, look for iWL252-01P2817A
   - For iWL258, look for iWL258-01P2733A
During installation and configuration, the keypad special keys function as follows:

- F3/Arrow Up: scroll up
- F2/Arrow Down: scroll down
- Enter: select highlighted item
- Cancel or Clear: previous screen
- Any button enables backlight

**Note:** These devices run on Retail Base Application (RBA). The version information is displayed on the device on boot up.

---

**Connecting the iWL252 to the UTG using Bluetooth**

The iWL252 can connect to UTG using Ingenico’s Bluetooth Smart Base station. To connect the Bluetooth Smart Base station to the UTG complete the following tasks:

1. Connect the Ingenico Smart Base to the UTG using one of the following methods:
   - **Serial cable** – If you are using a serial cable to connect the Smart Base to the UTG, set the comm type to Serial by completing the following step:
     - From the TDA menu, select 0 – Configuration, 0 - Communication and then, 0 – Select Comm. Type) and set the Comm Type to **Serial**.
   - **USB cable** – If you are using a USB cable to connect the Smart Base to the UTG, set the comm type to **USB<>Smart Base** by completing the following step:
     - From the TDA menu, select 0 – Configuration, 0 - Communication and then, 0 – Select Comm. Type) and set the Comm Type to **USB<>Smart Base**.
     - Note: The USB cable option requires RBA 17.06 or higher
2. Connect the device to the Ingencio Smart Base using one of the following methods:
   - Connect using the menu system.
     - Put the device on the smart base.
     - From the TSA System menu, select the **0 - TELIUM MANAGER**.
     - From the TELIUM MANAGER menu, select **3 - Initialization, 2 - Hardware, 4 - Cradle Setup, 1 – Association**.
     - Select 1-New Base and the device will attempt to synchronize with the base it is currently on.
   - Connect using the device while at the idle screens.
     - Put the device on the smart base.
     - Press the upper left button 4 times quickly.
     - After a few seconds the device should beep twice.

### Connecting the iWL258 to the UTG using Wi-Fi

Note: the Wi-Fi option requires RBA 17.06 or higher

You can connect the Ingenico iWL258 device directly to the UTG by using Wi-Fi by completing the following tasks.

1. Press the # button and the Yellow button together to turn the device off, then press the green button to restart the device.
2. When the copyright screen appears, quickly press **2, 6, 3, 4, Enter**, then press the **F** button for the menu screen and select TDA.
3. From the TDA menu, select **0 – Configuration, 0 - Communication and then, 0 – Select Comm. Type** and set the Comm Type to **Ethernet**.
4. From the TSA System menu, select the **0 - TELIUM MANAGER**.
5. From the TELIUM MANAGER menu, select **3 - Initialization, 2 - Hardware, 5 - Wi-Fi Setup**.
6. From the Wi-Fi Setup menu select **3 - IP Setup**.
7. Select 1-Boot Proto and select **Static Address** if you are assigning the device or **DHCP** if you are using DHCP to assign the IP address.
8. If you are using static IP addresses, you must configure the device’s IP Address by completing the following steps:
   - Select **2 – IP Address**.
     - Enter the IP address and press **Enter**. All three values of each octet must be entered so an IP address of 10.0.1.193 would be entered as 010.000.001.193.
   - Select **3 – Subnet Mask**.
     - Enter the Subnet Mask and press **Enter**. All three values of each octet must be entered so a Subnet Mask of 255.255.255.0 would be entered as 255.255.255.000.
   - Select **4 – Gateway**.
     - Enter the default gateway address and press **Enter**. All three values of each octet must be entered so a default gateway of 10.0.1.223 would be entered as 010.000.001.223.
9. From the Wi-Fi Setup menu select **1 – Profiles, 1 – New Profile**.
10. Select **Automatic Scan** to initial a search on the device for your Wi-Fi network.

11. If your Wi-Fi network is found, select your Wi-Fi network from the list and configure it by completing the following steps:
   - Select the Security Type.
   - Select the Cypher.
     - The highest level of encryption is recommended.
   - Enter your Wi-Fi password.
   - Enter the Priority.
     - If configuring the device for multiple Wi-Fi networks it will connect to them in the priority order.

12. If your Wi-Fi network is not found in the automatic scan, select **2 – Manual Connection** from the New Profile menu and complete the following steps:
   - From the hidden Access Point? prompt select **1 – No** if your access point is not hidden, and **2 – Yes** if it is hidden.
   - Enter your Wi-Fi's SSID.
   - Select the Cypher.
   - The highest level of encryption is recommended.
   - Enter your Wi-Fi password.
   - Enter the Priority.
     - If configuring the device for multiple Wi-Fi networks it will connect to them in the priority order.

13. Activate your Wi-Fi profile by completing the following steps:
   - From the Profiles menu select **2 – Active Profile**.
   - A list of Wi-Fi profiles will be displayed. Select the profile you want to use or select **1 – [Automatic]** to allow the device to select the Wi-Fi network based on the priority order set for each profile.

14. Modify an existing Wi-Fi profile by completing the following steps:
   - From the Profiles menu select **3 – Modify Profile**.
   - Select the profile you want to modify.
     - See the bullets in step 9 for modifying settings.

15. Delete an existing Wi-Fi profile by completing the following steps:
   - From the Profiles menu select **4 – Remove Profile**.
   - Select the profile you want to remove and press the green enter button.
Ingenico iUP250 Device Overview

The Ingenico iUP250 Telium RBA device is designed for unattended cashless payment in a self-service environment, such as a service station or kiosk. The iUR250 provides support for MSR and EMV. Currently, only MSR is supported by Shift4. The iUC150 provides a contactless reader.

During installation and configuration, the keypad special keys function as follows:

- Upper button next to the screen: Up
- Lower button next to the screen: Down
- Green V key: Enter (Validate your selection)

Placing the iUP250 in LLT Mode

To place the iUP250 module in LLT mode, complete the following steps:

- Switch on the modules power supply.
During the boot-up process, press the control button and hold until the LED light is orange (constant light, not blinking). (See the image below to locate the LED and button on the back of iUP250).

Connect your USB cable from the computer to the connector at the bottom left-hand corner of the iUP250.

The iUP250 screen should indicate “LLT”.

**Placing the iUP250 in Maintenance Mode**

To place iUP250 module in maintenance mode, complete the following steps:

- Switch on the modules power supply.
- During the boot-up process, press the control button and hold until the LED light is blinking orange. (See the image in the Placing the iUP250 in LLT Mode section for button and LED location) The screen will display a Maintenance mode message.
- Press the star “*” key on the keypad to access the maintenance menu.
- Use the Up/Down buttons on the right side of the screen to navigate the menus.
- Use the green “V” key to validate your selection.
MAINTENANCE MODE MENU

Maintenance menu choices:

- Telium Manager -> Usual Telium manager functions
- GETREADY -> To launch commissioning
- DEMO_IUN-> The demo settings

Ingenico Telium Devices RBA Versions Supported and Known Issues

<table>
<thead>
<tr>
<th>Ingenico Firmware</th>
<th>Supported?</th>
<th>P2PE Supported?</th>
<th>Description of Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telium RBA 13.0.4</td>
<td>Yes</td>
<td>Yes</td>
<td>DISABLEMCE option does not work, since the Ingenico device is not honoring the flag to hide the manual entry button. twb* packages do not work on iSMPc and iUP250 devices.</td>
</tr>
<tr>
<td>Telium RBA 14.0.4</td>
<td>Yes</td>
<td>Yes</td>
<td>DISABLEMCE option does not work, since the Ingenico device is not honoring the flag to hide the manual entry button. twb* packages do not work on iSMPc and iUP250 devices.</td>
</tr>
<tr>
<td>Telium RBA 14.0.6</td>
<td>Yes</td>
<td>Yes</td>
<td>DISABLEMCE option does not work, since the Ingenico device is not honoring the flag to hide the manual entry button. twb* packages do not work on iSMPc and iUP250 devices.</td>
</tr>
<tr>
<td>Telium RBA 15.0.6</td>
<td>Yes</td>
<td>Yes</td>
<td>twb* packages do not work on iSMPc and iUP250 devices.</td>
</tr>
<tr>
<td>Telium RBA 15.1.2</td>
<td>Yes</td>
<td>Yes</td>
<td>twb* packages do not work on iSMPc and iUP250 devices.</td>
</tr>
<tr>
<td>Telium RBA 16.0.2</td>
<td>Yes</td>
<td>Yes</td>
<td>twb* packages do not work on iSMPc and iUP250 devices.</td>
</tr>
<tr>
<td>Telium RBA 17.0.6</td>
<td>Yes</td>
<td>Yes</td>
<td>twb* packages do not work on iSMPc and iUP250 devices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>iUP250 devices not supported.</td>
</tr>
</tbody>
</table>
* .twb (This is a file extension used for update packages that can include RBA updates, forms, configuration settings, and security updates.)

**Requirement:** If you update from a device running UIA or a device running an RBA version prior to RBA 15.06, you must update to RBA 15.06 first, and then update to the latest RBA version. RBA 15.06 updates are available at [http://www.shift4.com/downloads/RBA1506Updates.zip](http://www.shift4.com/downloads/RBA1506Updates.zip)

To find the RBA version on the Telium device, complete the following steps:

1. Verify the UTG is not running
2. Reboot the device
3. The RBA version is displayed on boot up.

![Retail Base Screen](image)

**Note:** The RBA devices are set to automatically idle on startup, even when UTG is not running. This causes the Retail Base screen to show briefly before idling.

*Ingenico Telium RBA Device Serial Number and Settings*
Locating the Ingenico Telium RBA Device Serial Number for DOLLARS ON THE NET®

The serial number on an Ingenico Telium RBA device can be located externally and internally. This serial number will be needed by the Administrator to configure the EMV device correctly in DOLLARS ON THE NET. To find the serial number, use one of the methods listed below. When you have located the number, record it for later use.
Locating the Serial On the Back of the Device

On the back of the device, the serial number you will need to enter in DOLLARS ON THE NET will be the last eight digits of the serial number displayed after the ‘SC’, ‘PP’, or ‘UN’ text. See the example below.

![Serial Number Example](image)

Locating the Serial on the Device Screens

- From the menu of the Ingenico Telium RBA device, complete the following steps:
  - Select TSA
  - Select 0 – Terminal Serial #
  - The serial is the 8 digit number displayed under Hardware.

Rebooting the Device

To reboot the Ingenico Telium RBA device, complete the following steps:

- Touch iSC250/350/480: Simultaneously press and hold the Clear and Minus (-) buttons and then release. During boot-up, the device beeps and startup routines flash briefly on the screen.
- iPP320 [U.S.]/350: Simultaneously press and hold the Clear and Period (.) buttons and then release. During boot-up, the device beeps and startup routines flash briefly on the screen.
- iWL252/iWL258 /iCMP/iSMP Companion: Simultaneously press and hold the Clear and Period (.) buttons and then release. During boot-up, the device beeps and startup routines flash briefly on the screen.

Accessing the Telium System Menu

To access the Telium system menu complete the following steps:

1. Reboot the device.
2. When the device is displaying the RBA information screen complete the following:
   - Touch iSC250/350/480: Press 2, 6, 3, 4, Enter and then the Plus (+) button.
   - iPP320 [U.S.]/350: Press 2, 6, 3, 4, Enter and then the F button.
   - iWL252/iWL258 /iCMP/iSMP Companion: Press 2, 6, 3, 4, Enter and then the F button.
Setting Communication Type
To verify and set device communication type, complete the following steps:
1. From the Telium System menu, select the TDA menu.
2. From the TDA menu, select 0 – Configuration, 0 - Communication and then, 0 – Select Comm. Type.
   - If the device is connected via serial cable select 0 – Serial.
   - If the device is connected via Ethernet select 1 – Ethernet.
   - If the device is connected via USB cable select 3 – USB<>Serial Conv.
   - If the device is connected via Bluetooth select 5 – Bluetooth.
3. Press the Cancel/Clear button.

Setting Serial Communication Parameters
You must configure the serial communication parameters if your device is set as Serial, USB<>Serial Conv, or Bluetooth. To verify and set device serial communication parameters, complete the following steps:
1. From the Telium System menu, select the TDA menu.
2. From the TDA menu, select 0 – Configuration, 0 - Communication and then, 1 – Serial Settings.
3. Set or verify settings as listed in the following table:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Action Required</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate</td>
<td>Set</td>
<td>115200</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>Set</td>
<td>1</td>
</tr>
<tr>
<td>Bits per Byte</td>
<td>Set</td>
<td>8</td>
</tr>
<tr>
<td>Parity</td>
<td>Set</td>
<td>None</td>
</tr>
<tr>
<td>Flow Control</td>
<td>Set</td>
<td>None</td>
</tr>
</tbody>
</table>

4. Press the Cancel/Clear button until the Configuration menu returns.

Setting Ethernet Communication Parameters
You must configure the Ethernet communication parameters if your device is set as Ethernet. To verify and set Ethernet communication parameters, complete the following steps:
1. From the Telium System menu, select the TDA menu.
2. From the TDA menu, select 0 – Configuration, 0 - Communication and then, 2 – Ethernet Settings.
3. Select 0 – Connection Method and then select 1 – Server.
4. Press the **Cancel/Clear** button to return to the Ethernet settings menu.

5. Select 1 – **DHCP** and set your DHCP type to 0 – **Auto** if using DHCP or 1 – **Static** if you are using a static IP address.

| Note: If you are using DHCP for your Ethernet devices, you must ensure that they have a DHCP reservation so they always receive the same IP Address. If the IP Address changes, UTG will not be able to communicate with the device. |

6. Press the **Cancel/Clear** button to return to the Ethernet settings menu.

7. If you are using static IP addresses, you must configure the device’s IP Address as follows:
   a. Select 3 – **IP Address**
   b. Enter the IP address and press **Enter**. All three values of each octet must be entered so an IP address of 10.0.1.193 would be entered as 010.000.001.193.
   c. Select 4 – **Subnet Mask**
   d. Enter the Subnet Mask and press **Enter**. All three values of each octet must be entered so a Subnet Mask of 255.255.255.0 would be entered as 255.255.255.000.
   e. Select 5 – **Gateway**
   f. Enter the default gateway address and press **Enter**. All three values of each octet must be entered so a default gateway of 10.0.1.223 would be entered as 010.000.001.223.

8. Select 9 – **IP Port**.

9. Enter the port number that the device will listen on for UTG communication and press **Enter**.

10. Press the **Cancel/Clear** button until the Configuration menu returns.

### Other Settings

If you are using UTG Stub, verify that the following settings have been applied on the UTG Stub IP to Serial window:

- Baud Rate: 115200
- Data Bits (Byte Size): 8
- Parity: None
- Stop Bits: 1

| Requirement: You must load the Shift4 template forms on the devices. Refer to *Downloading the Shift4 Template Forms for Ingenico Devices* in this document. |
**UTG Configuration Settings for Ingenico Telium RBA Devices**

**BIN Range Overrides**
Ingenico Telium RBA devices provide a BIN Range Overrides option. The BIN Range Overrides option allows a merchant to require CVV for credit cards, but bypass CVV for certain cards such as gift cards that may not have a card security code. This feature can also be used to bypass Luhn checking and Expiration Date, CVV, Street, and Postal Code prompting. Up to nine separate BIN ranges can be configured.
Example of BIN Range Overrides

Consecutive BIN Range Overrides
In the example below, the merchant has two separate gift card ranges that will bypass CVV. BIN Range Overrides will begin at the top listed range. Any card number that is manually entered and falls within the top listed range will not prompt for CVV. If the card number does not fall within the top listed range, the next listed range will be considered.

![BIN Range Overrides](image)

Nested BIN Range Overrides
Nested BIN Range Overrides can also be created. To create a nested BIN range override, enter the smaller subrange first, followed by the larger range.
In the example below, a merchant has a large range of gift cards that will need to bypass CVV and Exp Date. The merchant also has a smaller subrange of cards the will only bypass CVV. BIN Range Overrides begins at the top listed range. If the manually entered card number falls within the top listed range, the configured bypass selections will be applied. If the card number does not fall within the top listed range, the next listed range will be considered.

![BIN Range Overrides](image)

**Important:** BIN Range Overrides look for the first listed range containing the card number entered and applies the configured bypass selections. Therefore it is important to list the smaller subrange first.
Line Item Details on the PIN Pad

It is possible to display line item details on Ingenico Telium RBA non-mobile devices and the iWL252/iWL258 mobile devices. This feature is automatically enabled as long as the POS/PMS supports it and the required forms are loaded on the device. The default forms for the Telium RBA devices support displaying the line items on the majority of the forms and the line item content is maintained while switching between forms.

Ingenico Telium RBA Contactless

The Ingenico Telium RBA devices have the ability to enable or disable contactless processing. Contactless support is enabled by default. To disable contactless on a configured device, complete the following steps:

1. In UTG TuneUp, click the Devices tab.
2. Double-click the device to be edited.
4. Click OK.

5. Click Save.
Ingenico Telium RBA Bypass Amount Support

Ingenico Telium RBA devices have the ability to enable Bypass Amount OK. If selected, the device will not prompt for amount confirmation.
Ingenico Telium RBA EBT Support

The Ingenico Telium RBA devices have the ability to enable or disable Electronic Benefit Transfer (EBT) processing. EBT processing is disabled by default. To enable EBT processing, complete the following steps:

1. In UTG TuneUp, on the Add Device screen, locate and select one or both of the following options:
   - EBT Cash Enabled
   - EBT Food Enabled

2. Click **OK**.

3. Click **Save**.
Configuring Ingenico Telium RBA Line Length Support

The Ingenico Telium RBA devices have the ability to wrap text on the List Box elements based on the Line Length setting in UTG TuneUp. UTG will wrap the text at the number of characters specified in the Line Length setting. The default values work best with the default Shift4 forms, however if you change the font or font size on the List Box elements when customizing the forms you will need to adjust this value accordingly.
Configuring Ingenico Telium RBA Beep Volume

You can control the volume of Ingenico Telium RBA devices from UTG TuneUp. This is the volume level the device will beep for actions, such as pressing a button, or EMV card removal prompt.

To set the volume level, complete the following steps:

1. Select the desired Ingenico Telium RBA device from the Device Type list.
2. Enter any number between 0 and 100 considering the following:
   - Entering 0 = volume off
   - Entering 100 = full volume
3. Click OK.
4. Click Save.
Configuring Ingenico Telium RBA Debit Key Index

The Ingenico Telium RBA devices have the ability to be injected with up to five keys. This allows the same device to be used for multiple processors. Debit Key Index 0, 1, 2, 3, and 5 are available. Debit Key Index 4 is reserved for P2PE keys. The default is 0.

Examples of Using Debit Key Index

Multiple Locations with Multiple Processors
A merchant has a large number of locations that span a number of processors. Being able to inject multiple debit keys into a single device will reduce the need for a large inventory of devices with separate keys for every processor. If the merchant needs to swap out a device at location A that uses different processor than location B they can, since all of their devices will have the necessary keys.

Mobile Merchant
A merchant sells at various races. Some race locations use different processors. Rather than having to purchase separate devices per processor, the merchant can have a single device with up to 5 debit keys injected. This enables the merchant to simply change the debit key index to match the processor at each race location.
Ingenico Telium RBA Source Serial Number Support

The Ingenico Telium RBA devices have the ability to download card ranges and EMV settings based on the Shift4 serial number under which UTG is configured.

Some merchant’s UTGs are configured for a different Shift4 serial number than where the Shift4 merchant ID is set up. If your UTG is already configured for the Shift4 serial number where the merchant ID is set up, leave the Source Serial Number field blank.

If the UTG is configured for a different Shift4 serial number, enter the Shift4 serial number where the merchant ID is set up in the Source Serial Number field.
Default Language Selection

If you are using an Ingenico RBA device, UTG TuneUp allows you to select a default language for the device you are configuring. Current options include English, Spanish, and French.

Ingenico Telium RBA Tip

UTG TuneUp allows you to configure Tip settings for Ingenico Telium RBA devices. If Enable Tip is selected, there are three configuration options to choose from when prompting for a tip:

1. You can prompt for the consumer to enter a tip amount when prompting for a tip by completing the following steps:
   - Select Enable Tip
   - Select No Presets.

2. You can configure preset tip percentages that will be displayed on the device when prompting for a tip by completing the following steps:
   - Select Enable Tip.
   - Select Percent.
   - Enter the desired percentages that will be displayed when prompting for tip.

3. You can configure fixed amount values that will be displayed on the device when prompting for a tip by completing the following steps:
   - Select Enable Tip.
- Select **Amount**.
- Enter the desired amounts that will be displayed when prompting for tip.

**Note:** If **Enable Tip** is selected, the tip screen will also provide an **Other** option that allows the consumer to enter a custom tip amount and a **No** option for no tip that will be displayed on the device.

The example below displays a configuration where tip is enabled, percent is selected, and only three percentages will be displayed when prompting for tip. For more information on configuring this feature, see the UTG *Quick Installation Guide*.

![Tip Parameters](image)

**Note:** Percent and Amount fields are displayed on the device from left to right. Entering a zero in any of the fields will cause that field to not be displayed on the PIN pad. For example, if you select percent and only want to display 3 tip options (10%, 15%, and 20%), you could enter zero in the First Percent field, 10 in the Second Percent field, 15 in the Third Percent field, and 20 in the Fourth Percent field. Only the first three fields would be displayed on the PIN pad.
Ingenico Telium RBA Form Flexibility

The Ingenico Telium RBA devices provide the merchant the ability to modify the current Ingenico PIN Pad forms to match their branding.

Downloading the Shift4 Template Forms for Ingenico Devices

To download and extract the Shift4 template forms, use the links in the table below.

1. Download the template forms for your Ingenico device from the Shift4 website:

<table>
<thead>
<tr>
<th>For this device...</th>
<th>Download the template forms here...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ingenico iSC480™ RBA</td>
<td><a href="http://www.shift4.com/downloads/iSC480RBAforms.zip">http://www.shift4.com/downloads/iSC480RBAforms.zip</a></td>
</tr>
<tr>
<td>Ingenico iCM122™ RBA</td>
<td><a href="http://www.shift4.com/downloads/iCM122RBAforms.zip">http://www.shift4.com/downloads/iCM122RBAforms.zip</a></td>
</tr>
<tr>
<td>Ingenico iMP352™ RBA</td>
<td><a href="http://www.shift4.com/downloads/iMP352RBAforms.zip">http://www.shift4.com/downloads/iMP352RBAforms.zip</a></td>
</tr>
<tr>
<td>Ingenico iUP250™ RBA</td>
<td><a href="http://www.shift4.com/downloads/iUP250RBAforms.zip">http://www.shift4.com/downloads/iUP250RBAforms.zip</a></td>
</tr>
</tbody>
</table>

2. Save the zip file.

3. Extract the files:
   - Open the zip file and click **Extract all files**.
   - In the Extract window, navigate to the folder where you want to save the template forms and click **OK**.
   - Once extracted there will be a Forms folder containing the default forms, a Manual Update folder containing the manual RBA update file, and a Package folder containing an Ingenico package file.
Ingenico RBA Package File

The Ingenico RBA package file contains the following:

- Latest supported version of RBA
- P2PE security file to enable P2PE
- Shift4 default forms and custom prompts

The Ingenico RBA package file makes it easy to update an existing RBA device to the correct version of RBA while re-enabling P2PE and loading our default forms all in one file push. Updating the UIA/RBA version prior to this package file would require pushing all three files separately. This package file can also be used to easily convert an Ingenico Telium UIA P2PE device to RBA.

Downloading Ingenico Telium Tools


The files will include the following:

- Telium Data Packager – Data packaging tool to generate an RBA package file
- Telium Jungo Driver – Ingenico's USB driver
- Telium LLT – Ingenico's local loading tool used to push files to Ingenico devices.
- Telium Tools – Includes the form builder and form packager applications used for customizing Ingenico forms
Using the Ingenico Local Load Tool to Load the Template Forms

LLT (Local Load Tool) allows users to load forms onto the Ingenico TELIUM devices.

**Requirement:** Close all programs and shut down all services using the Ingenico device, including UTG, UTG Stub, and UTG Service before loading forms.

1. Set the PIN Pad into the LLT mode by completing the following steps:
   - Touch iSC250/350/480: reboot the PIN Pad and holding the minus (-) button while it boots up.
   - iPP320 [U.S.]/350: reboot the PIN Pad and continuously press the F button until a menu appears. Select Download then Local Download. The PIN Pad screen will display LLT.
   - iWL, iCMP & iSMP Companion: reboot the PIN Pad and continuously press the F button until a menu appears. Select Download then Local Download. The PIN Pad screen will display LLT.

2. Select Start > Programs > TELIUM Tools > LLT 4.5.2 (this version number may vary depending on your download)

3. Click LLT 4.5.2

4. To configure LLT to connect to the correct COM Port, see the LLT User Guide.pdf for instructions. It should be located in the Telium LLT folder.

5. Select Terminal > Connection.

6. In the All directories (left side) pane, select the folder where you extracted the Ingenico devices forms/package.

7. From the drop down list (above the middle pane), select *.*. This will display all of the forms in the middle pane.

8. Verify that the dropdown list above the Terminal view pane displays *.* to view all files on the PIN Pad.

9. Above the Terminal view (right side) pane, click until you reach the top level.

10. Double click HOST.

11. Select all files in the middle pane and drag them into the Terminal view pane.
12. Select **Terminal > Disconnect**. The PIN Pad should automatically reboot.

![Image of Local Leading Tool](image)

**Editing Shift4 Template Forms for Ingenico Telium Devices**

Ingenico devices include editable forms. This allows merchants to add specific wording and logos on individual forms or in the background of every form. Portions of the Shift4 template forms, such as images, button placement, and text placement, can be edited with the Telium Form Builder.

---

**WARNING!** Do not change the Attribute ID for any item or the UTG will not work properly. See the table below for more information.

<table>
<thead>
<tr>
<th>Common Controls</th>
<th>What can be edited?</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCTT ctt</td>
<td>CCTT ctt controls may be moved but the text and control size should not be changed.</td>
</tr>
<tr>
<td>Image image</td>
<td>Image image controls may be changed, deleted, moved, or resized as needed. You may also add images and backgrounds.</td>
</tr>
<tr>
<td>Label lbl</td>
<td>Label lbl controls may be created or moved but existing labels should not be modified or deleted.</td>
</tr>
<tr>
<td>LineDisplay linedisplay</td>
<td>LineDisplay linedisplay controls may be moved but should not be renamed, resized, or deleted.</td>
</tr>
<tr>
<td>Bmp Button</td>
<td>Bmp Button controls may be moved and the image may be changed. Bmp Buttons may even be deleted if only the keypad is to be used.</td>
</tr>
</tbody>
</table>
### Common Controls

<table>
<thead>
<tr>
<th>What can be edited?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signature sig controls may be moved or resized. Also, the backgroundcolor, inkcolor, and pensize may be changed.</td>
</tr>
<tr>
<td>PINEntry pinentry controls may be moved but not resized and the text must not be changed.</td>
</tr>
</tbody>
</table>

---

The following table provides descriptions for the Shift4 forms or file names for the Ingenico Telium devices.

<table>
<thead>
<tr>
<th>Form Name</th>
<th>File Name (Do Not Change)</th>
<th>RBA Version</th>
<th>Form Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advertisement Display</td>
<td>ads.K3Z</td>
<td>All</td>
<td>When the system is idle, it displays this form and uses the ads.dat to determine which images to cycle through</td>
</tr>
<tr>
<td>Alphanumeric Keyboard Entry</td>
<td>alpha.K3Z</td>
<td>All</td>
<td>This form includes an on-screen keyboard that is used for alphanumeric text entry</td>
</tr>
<tr>
<td>Form Name</td>
<td>File Name</td>
<td>RBA Version</td>
<td>Form Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------</td>
<td>-------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Alphanumeric Keyboard Entry</td>
<td>alphaNew.K3Z</td>
<td>All</td>
<td>This form includes an on-screen keyboard that is used for alphanumeric text entry</td>
</tr>
<tr>
<td>Amount Verification</td>
<td>BAMTV.K3Z</td>
<td>All</td>
<td>Displays the amount confirmation screen</td>
</tr>
<tr>
<td>Approved/Declined</td>
<td>appdapp.K3Z</td>
<td>All</td>
<td>Displays the approved/declined message for EMV transactions</td>
</tr>
<tr>
<td>Approved/Declined</td>
<td>BAPPDAPP.K3Z</td>
<td>All</td>
<td>Displays the approved/declined message for non-EMV transactions</td>
</tr>
<tr>
<td>Message Display</td>
<td>BMSG.K3Z</td>
<td>All</td>
<td>Used to display various messages to the cardholder</td>
</tr>
<tr>
<td>Credit/Debit Selection</td>
<td>BPAY.K3Z</td>
<td>All</td>
<td>Displays the credit/debit selection screen for non-EMV transactions</td>
</tr>
<tr>
<td>Terms and Conditions</td>
<td>BTC.K3Z</td>
<td>All</td>
<td>Displays the terms and conditions screen</td>
</tr>
<tr>
<td>Terms and Conditions Checkbox</td>
<td>BTCC.K3Z</td>
<td>All</td>
<td>Displays the terms and conditions screen with an acknowledgement checkbox that must be checked to enable the accept button</td>
</tr>
<tr>
<td>Terms and Conditions Signature</td>
<td>BTCSIGN.K3Z</td>
<td>All</td>
<td>Displays the terms and conditions signature screen</td>
</tr>
<tr>
<td>Cash Back Selection</td>
<td>BCASHB.K3Z</td>
<td>All</td>
<td>Displays the cash back selection screen</td>
</tr>
<tr>
<td>Tip Preset</td>
<td>BTIPPRESET.K3Z</td>
<td>All</td>
<td>This displays the Tip entry screen with preset percent/amount buttons when enabled.</td>
</tr>
<tr>
<td>Insert/Swipe Card</td>
<td>CARD.K3Z</td>
<td>All</td>
<td>Displays the card entry screen for the cardholder to insert/swipe/tap their card. Does not include a manual entry button.</td>
</tr>
<tr>
<td>Insert/Swipe Card with Manual Entry</td>
<td>CARDM.K3Z</td>
<td>All</td>
<td>Displays the card entry screen for the cardholder to insert/swipe/tap their card. Includes a manual entry button.</td>
</tr>
<tr>
<td>Form Name</td>
<td>File Name</td>
<td>RBA Version</td>
<td>Form Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EMV Account Selection</td>
<td>eaccount.K3Z</td>
<td>All</td>
<td>Displays the account selection screen for EMV transactions</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Future use</td>
</tr>
<tr>
<td>EMV Application Confirmation</td>
<td>econfirm.K3Z</td>
<td>All</td>
<td>Displays the application selection confirmation screen for EMV transactions</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Future use</td>
</tr>
<tr>
<td>EMV Language Selection</td>
<td>elang.K3Z</td>
<td>All</td>
<td>Displays the language selection screen for EMV transactions</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Future use</td>
</tr>
<tr>
<td>Input</td>
<td>input.K3Z</td>
<td>All</td>
<td>Displays the various prompts for input to the cardholder including card number, expiration date, CVV, etc.</td>
</tr>
<tr>
<td>Language Selection</td>
<td>lang.K3Z</td>
<td>All</td>
<td>Displays the language selection screen for non-EMV transactions</td>
</tr>
<tr>
<td>Menu</td>
<td>menu.K3Z</td>
<td>All</td>
<td>Displays a menu selection to the cardholder. Used for EMV application selection when there are multiple applications to choose from</td>
</tr>
<tr>
<td>Message Display</td>
<td>msg.K3Z</td>
<td>All</td>
<td>Used to display various messages to the cardholder</td>
</tr>
<tr>
<td>Message Display</td>
<td>msgthick.K3Z</td>
<td>All</td>
<td>Used to display various messages to the cardholder</td>
</tr>
<tr>
<td>Offline</td>
<td>offline.K3Z</td>
<td>All</td>
<td>The device will display this form when in a lane closed state</td>
</tr>
<tr>
<td>Offline Video</td>
<td>offlinevid.K3Z</td>
<td>All</td>
<td>Form used to display a video while offline</td>
</tr>
<tr>
<td>PIN Entry</td>
<td>pin.K3Z</td>
<td>All</td>
<td>Displays the PIN entry form</td>
</tr>
<tr>
<td>Signature</td>
<td>sign.K3Z</td>
<td>All</td>
<td>Displays the signature screen for approved transactions</td>
</tr>
<tr>
<td>Form Name</td>
<td>File Name (Do Not Change)</td>
<td>RBA Version</td>
<td>Form Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------</td>
<td>-------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Advertisement Display Settings</td>
<td>ADS.DAT</td>
<td>All</td>
<td>Contains the settings for which images to display during the idle process and how long to display them</td>
</tr>
<tr>
<td>Custom Prompt Signature File</td>
<td>CUSTPROMPT.PGZ</td>
<td>All</td>
<td>Contains the digitally signed version of the custom prompt file.</td>
</tr>
<tr>
<td>Security Settings File</td>
<td>SECURITY.PGZ</td>
<td>All</td>
<td>Enables P2PE and sets the P2PE masking character to an asterisk</td>
</tr>
</tbody>
</table>
UTG Automatic Form Loading and RBA Update

The UTG has the ability to push new forms or RBA version updates to all compatible devices. This enables merchants to create custom, seasonal, or promotional forms that can be quickly and easily deployed. Merchants can also update the RBA version on multiple devices using the same feature. The supported file extensions UTG will push for Telium devices include the following:

- .K3Z (forms)
- .DAT (configuration settings)
- .TGZ (packages of forms)
- .PGZ (security updates)
- .OGZ (RBA updates)
- .twb (update packages that can include RBA updates, forms, configuration settings, and security updates)
- .RKI (remote key injection)
- .XML (configuration settings)

**Requirement:** RBA 8 or higher is required for pushing .twb files.

To push forms or RBA updates to all compatible devices, complete the following steps:

**Requirement:** For Telium P2PE devices, RBA updates are generic and do not take P2PE into account. If an RBA update is pushed to a Telium P2PE Device, the SECURITY.PGZ file must also be run following the push in order to continue using P2PE on the device. The SECURITY.PGZ file is included in the Shift4 template forms folder.

1. *(If applicable)* For form changes, create a package of forms using the Ingenico Telium Data Packaging Tool. This file should have a “.TGZ” extension.
2. *(If applicable)* For RBA updates, you should have a file with an “.OGZ” extension or a package with a “.twb” extension.
3. Copy any of the supported file types listed above to `...\Shift4\UTG2\Update\Forms\[DeviceType]` where `[DeviceType]` represents the type of Telium device. For example: `...\Shift4\UTG2\Update\Forms\Ingenico iSC250 RBA`. Other device types include the following:
   - Ingenico iSC250 RBA
   - Ingenico iSC350 RBA
- Ingenico iSC480 RBA
- Ingenico iPP320 RBA
- Ingenico iPP350 RBA
- Ingenico iWL252 RBA
- Ingenico iWL258 RBA
- Ingenico iCM122 RBA (See note below)
- Ingenico iMP352 RBA
- Ingenico iUP250 RBA (See note below)

**Note:** Ingenico .twb packages will not successfully install an Ingenico .twb package.

**Note:** There should only be one set of forms in the folder. If you have a previous package of forms, make a copy and store in another folder for future use.
4. Create a new text file in the same directory where the package file or RBA version update file is placed and name the file `Update.txt`. The `Update.txt` file should not contain any content. It is simply for triggering the update.

5. The UTG will look for an Update.txt file every 30 seconds while idling. When an Update.txt file is present, the UTG will push the package of forms or RBA update to each of the compatible devices connected to the UTG.

6. The devices will display Updating Files Please Wait while the UTG is pushing the package or RBA update to the devices.

7. Once the package of forms or RBA version update has been pushed to all compatible devices, the UTG will reboot all compatible devices.

8. When the reboot process is complete, the UTG will verify all the forms have loaded. The message Verifying Forms Please Wait will be displayed on all compatible devices.
   - If any forms are missing, the UTG will display a message on the device indicating which forms are missing. The missing forms must be added before the device can be used.
   - If all of the forms are present, the UTG will display the idle screens on the devices.

9. The UTG will then delete the Update.txt file.

---

**Note:** To prevent problems from downloading forms to too many devices at once, set the **Limit Simultaneous Downloads** in TuneUp on the Devices tab to a lower number. See the UTG Quick Installation Guide for more information.
Pushing Forms/Package Updates to Selected Ingenico Telium RBA Devices Using UTG Standalone

To push forms/package updates to selected Ingenico Telium RBA devices, complete the following steps:

1. Complete the first three steps in the UTG Automatic Form Loading and RBA Update section.
2. Do not create or include the Update.txt file. Without the Update.txt file, the forms will not automatically load.
3. Place the forms package in the normal update directory.
4. With the UTG Standalone running, right click anywhere on the Standalone screen to display the Device Maintenance window.
5. In the Device Maintenance window, click Device Maintenance.
6. From the listed devices, select the desired PIN pads.
7. Click Push Forms to push the forms/package updates to the selected PIN pads while the UTG is running.
Using the Ingenico Telium Form Builder

To link the custom prompts to Telium Form Builder complete the following steps:

1. Click **Tools > Options**.
2. Click **Prompts** in the left pane.
3. Click [ ] on the SECURPROMPT File line.
4. Browse the directory where you extracted the PIN Pad device forms.
5. Select the SECURPROMPT.XML file and click **Open**.
6. Click [ ] on the PROMPT File line.
7. Browse the directory where you extracted the PIN Pad device forms.
8. Select the PROMPT.XML file and click **Open**.
9. Click the [ ] button on the CUSTPROMPT File line.
10. Browse the directory where you extracted the PIN Pad device forms.
11. Select the CUSTPROMPT.XML file and click **Open**.
12. Click **OK** to close the Options window.

To edit the Shift4 template forms in the Telium Form Builder:

1. From the Telium Form Builder menu, select **File > Open** and select the form to edit.
2. Double-click the file to be edited.
3. With the form loaded in the Telium Form Builder window, click the field you want to edit.
4. Modify the images, text placement and button placement as desired.
5. When finished editing, select **File > Save** to save your changes.
6. Load all modified forms on to your device using the instructions above.

**Updating an RBA Package to Utilize Branded Forms**

The RBA package can be updated to include branded forms so that a single file push to the device will update the RBA version, enable P2PE and load the branded forms. To update the RBA package to include your branded forms instead of the default Shift4 forms complete the following steps:

---

**Note:** If you are planning to just update the forms on the device without the need to update the RBA version, it is recommended that you simply push the forms ".TGZ" file instead of the entire RBA package.

---

1. Download the Shift4 RBA forms for the device you are planning to update.
2. Extract the forms zip file to a temporary directory.
3. Modify the forms as needed to match your company’s branding.
4. Using the Ingenico Data Packager tool open the RBA package.

5. Click [image].

6. Select all of the image files, then right click and select Remove Files.
7. Right click and select **Add Files…**

8. Browse to the directory where you have your modified forms files, select all and click **Open**.

9. Click ![Add Files](image)

10. Select all of the form files then right click and select **Remove Files**.
11. Right click and select Add Files….

12. Browse to the directory where you have your modified forms files, select all and click Open.

13. Do not modify any of the other sections within the data packager.

14. Generate the package by clicking Build.

15. Make sure the Package Type dropdown is set to twb.

16. Select the target terminal and click Build.

17. Browse to the directory where you want to save the package file, enter a file name, and click Save.
Converting a **UIA device to RBA**

The quickest way to convert a device currently running UIA to RBA is to push the Shift4 RBA package. If the package option is not available, you can push the RBA update manually. Since RBA only supports P2PE implementations, the existing UIA device must already have P2PE enabled in order to update it without returning the device to a key injection facility.

---

**Requirement:** The device must already have a P2PE key injected in order to update it without sending it back to a key injection facility. If the device is not currently a P2PE device it will not work once converted to RBA.

---

Converting a **P2PE UIA device to RBA via Shift4 Package**

To convert a P2PE UIA device to run RBA using the Shift4 .twb package file perform the following steps:

---

**Requirement:** The UIA device must be running UIA 8 or higher in order to push ".twb" files.

---

1. Download the Shift4 RBA forms for the device you are planning to update.
2. Modify the forms as needed to match your branding.
3. Add the updated forms to the RBA package. See the *Updating an RBA Package to Utilize Branded Forms* section for more details.
4. Ensure that UTG is still configured for the UIA version of the Ingenico Telium P2PE device.
5. Utilize UTG’s automatic form loading functionality to push the RBA package to the device.
6. After the package has been pushed to the device and the device reboots, shut down UTG.
7. Reconfigure UTG TuneUp to utilize the RBA version of the Ingenico Telium device.
8. Start UTG.
Converting a P2PE UIA device to RBA via manual update

Locate the update instructions for your specific P2PE UIA version in the sections below. Some devices may require multiple sections.

Manually Converting P2PE UIA Devices Prior to UIA Version 8 to Run RBA

To convert a P2PE UIA device to run RBA manually, complete the following steps:

1. Download the Shift4 RBA forms for the device you are planning to update.
2. Ensure that UTG is still configured for the UIA version of the Ingenico Telium P2PE device.
3. Utilize UTG’s automatic form loading functionality to push the RBA “.OGZ” file to the device. The “.OGZ” file can be found in the Manual folder, inside the device forms zip folder downloaded in step 1, as displayed below:

![Image of file structure]

4. After the RBA “.OGZ” package has been pushed to the device and the device reboots, shut down UTG.
5. Reconfigure UTG TuneUp to utilize the RBA version of the Ingenico Telium device.
6. Start UTG.

Note: This option should only be utilized if the device is running a UIA version prior to UIA 8.
7. Utilize UTG’s automatic form loading functionality to push the RBA TDES.PGZ file to the device. The “.PGZ” file is also located in the Manual folder inside the device forms zip folder downloaded in step 1, as displayed below:

8. The device will reboot after the RBA “.PGZ” package has been pushed.

9. Download the Shift4 RBA forms for the device you are using.

10. Extract the forms zip file to a temporary directory.

11. Modify the forms as needed to match your company’s branding.

12. Create a “.TGZ” forms package using Ingenico Telium Packaging Tool.

13. Utilize UTG’s automatic form loading functionality to push the “.TGZ” forms package file to the device.

**Updating Telium Devices with UIA Versions 8, 9, and 3.3 Overview**

Some Ingenico Telium devices require sequential updates to bring them to the current RBA version 17.06 build. The following content provides an overview of the required steps.

- **Telium Devices with UIA version 8**
  - These devices must be updated to UIA version 9.04 using the following download link: [www.shift4.com/downloads/UIA904Updates.zip](http://www.shift4.com/downloads/UIA904Updates.zip).
  - After the devices are updated to UIA version 9.04, they must be updated to RBA version 15.06 using the following download link: [www.shift4.com/downloads/RBA1506Updates.zip](http://www.shift4.com/downloads/RBA1506Updates.zip).
  - After the devices are updated to RBA version 15.06, they must be updated to the latest RBA build. The current build is RBA version 17.06.

- **Telium Devices with UIA Versions 9 and 3.3**
  - These Devices must be updated to RBA version 15.06 using the following download link: [www.shift4.com/downloads/RBA1506Updates.zip](http://www.shift4.com/downloads/RBA1506Updates.zip).
  - After the devices are updated to RBA version 15.06, they must be updated to the latest RBA build. The current build is RBA version 17.06.

**Updating Telium Devices with UIA version 8**

To update Telium Devices with UIA Versions 8, complete the following steps:

2. Extract the contents of the zip file to your desired location.
3. Open the extracted contents and find the folder that matches the model of your device.
4. Open the folder and locate the .OGZ file.
5. Copy the .OGZ file to the \Shift4\UTG2\Update\Forms\[DeviceType P2PE] folder where DeviceType represents the model of your Telium device.

6. Start the UTG

7. To push the .OGZ package to the devices automatically, complete the following steps:
   a. Create a new text file in the same directory where the package file or RBA version update file is placed and name the file Update.txt. This can be done using Notepad.
   b. The UTG will push the file, and the devices will display Updating Files Please Wait while the UTG is pushing the package or RBA update to the devices.
   c. Once the UIA version update has been pushed to all compatible devices, the UTG will reboot them.
   d. When the reboot process is complete, the UTG will verify all the forms have loaded. The message Verifying Forms Please Wait will be displayed on all compatible devices.
   e. The UTG will then delete the Update.txt file.

8. Follow the steps in the Updating Telium Devices with UIA Version 9 and 3.3 section.

Updating Telium Devices with UIA Versions 9 and 3.3

To update Telium Devices with UIA Versions 9 and 3.3, complete the following steps:

1. Download the RBA forms package for RBA Version 15.06 using the following download link: http://www.shift4.com/downloads/RBA1506Updates.zip.

2. Extract the contents of the zip file to your desired location.

3. Open the extracted contents and find the folder that matches the model of your device.

4. Open the folder and locate the .OGZ file.

5. Copy the .OGZ file to the \Shift4\UTG2\Update\Forms\[DeviceType P2PE] folder where DeviceType represents the model of your Telium device.

6. Start the UTG.

7. To push the .OGZ package to the device automatically, complete the following steps:
   a. Create a new text file in the same directory where the package file or RBA version update file is placed and name the file Update.txt. This can be done via Notepad.
   b. The UTG will start to push the file. The devices will display Updating Files Please Wait while the UTG is pushing the package or RBA update to the devices.
   c. Once the RBA version update has been pushed to all compatible devices, the UTG will reboot them.
   d. When the reboot process is complete, the UTG will verify all the forms have loaded. The message Verifying Forms Please Wait will be displayed on all compatible devices.
   e. The UTG will then delete the Update.txt file.

8. Stop the UTG service by completing the following steps:
   • To shut down UTG Standalone, select File > Exit and click Yes when prompted to confirm shut down.
     o If UTG Standalone is in use, it may be necessary to select Override before clicking Yes.
   • To shut down the UTG service, stop the Shift4 UTG (v2) service from the Windows Services menu.


10. In UTG TuneUp, select the Devices tab and complete the following steps for each listed device.
    a. Double click on the device.
    b. From the Device Type list, select the same device type but with an RBA extension. For example, if your current device is an Ingenico iPP320 select Ingenico iPP320 RBA.
    c. Click OK on the device window.
11. Repeat steps a through c above for any additional devices you want to update.
12. Click **Save** on the main Universal Transaction Gateway TuneUp window to save all your updates.
13. Restart the UTG Service.
14. To upgrade the RBA firmware to the latest version supported for EMV processing, download the RBA forms package for the appropriate device. See the table in the *Downloading the Shift4 Template Forms for Ingenico Devices* section for the download links.
15. Extract the contents of the zip file to your desired location.
16. From the extracted contents locate the `[DeviceType]RBA.twb` file in the Packages folder.
17. Copy the `.twb` file to `...\Shift4\UTG2\Update\Forms\[DeviceType RBA]` folder where `DeviceType` represents the type of your Ingenico Telium device.
18. Delete the `.OGZ` file used for the prior update before continuing, as the UTG will keep the file and try pushing it to the devices again.
19. Start the UTG
20. To push the `.twb` package to the device automatically, complete the following steps:
   a. Create a new text file in the same directory where you placed the `.twb` package file from the previous step and name the file `Update.txt`. This can be done via Notepad.
   b. The UTG will start to push the file contents to all devices configured in the UTG Tune Up. The devices will display *Updating Files Please Wait* while the UTG is pushing the RBA update to the devices.
   c. Once the RBA version update has been pushed to all compatible devices, the UTG will reboot them.
   d. When the reboot process is complete, the UTG will verify all the forms have loaded. The message *Verifying Forms Please Wait* will be displayed on all compatible devices.
   e. The UTG will then delete the `Update.txt` file.

**Converting a non-P2PE UIA device to RBA**

You will need to send your device back to the key injection facility to load the P2PE key and the RBA application.

**Configuring Ingenico iPP320 CAN**

The iPP320 CAN is an EMV device that is designed for Canadian use.

**Booting the Device and Changing Settings**

To boot the device, complete the following steps:

1. Simultaneously press the yellow button and the period button to power cycle the device.
2. When the device boots to the screen showing the device serial number at the bottom, the `?` character will be displayed for a few seconds. Press the green enter button while the `?` is displayed.
3. Press **F4** to cycle through the menu options.
4. Press the **yellow** button to change the setting on an option.
5. Press the **green (enter)** button to save your changes.
Verifying Device Settings

- Com Port: Select RS232 for a serial device, or select USB 9600 for a USB device

Other Settings

Verify that the following settings have been applied on the UTG Stub IP to Serial window:

- Baud Rate: 9600
- Data Bits: (Byte Size): 7
- Parity: Even
- Stop Bits: 1
- Flow Control: None

---

**Note:** Since the Ingenico iPP320 CAN does not utilize a set of forms, the Automatic Form Loading feature is not available for this device.

---

### Ingenico iPP320 CAN MAC Values

**Issue:** When manually entering more than 3 digits on the Enter Card Number, Enter Expiration Date, Enter Tip, or Enter Cashback Screens, the device beeps and the transaction is cancelled. How do I fix this?

**Solution:** This is caused by the clear text prompts being loaded with an incorrect MAC value. To resolve this issue, perform the following steps:

1. Obtain the correct MAC values for all of the clear text prompts. The UTG installs a text file containing the default processor MAC values. The file is located in the directory C:\Shift4\EMV and is called “processorname Clear Text Prompts.pmt” where processorname is the name of your processor such as Global or Paymetech. (For Global Payments, there is a test file “Global Clear Text Prompts - Test.pmt” and a production file “Global Clear Text Prompts - Production.pmt.”)
   
The file is broken down with a header line followed by each prompt on its own line. Each prompt consists of three fields separated by colons. The first field in the prompt text is in quotes followed by the prompt MAC index then the prompt MAC (see image below):
2. Once you have the correct MAC values from the processor, create a copy of the default text file from your processor and change the MAC value for each of the prompts to the one you received from the processor. Make sure that you do not change the text or the MAC index.

3. Save and close the file.

4. From the UTG Stand Alone screen, right click anywhere and select Device Maintenance.

5. Select the device(s) to which you would like to apply the new prompts and click **Apply Prompts**.

---

**Note:** If the default MAC values from the text file do not work, you will need to contact your processor for the correct MAC values.
6. The iPP320 CAN device displays a Please Wait message while attempting to load the prompts and goes back to Idle when finished.

7. Test the prompts by attempting to enter more than 3 digits on the screen(s) that failed previously.

iPP320 Interac Debit Key Exchange

Should your Ingenico iPP320 device get out of sync, a debit key exchange can be performed by completing the following steps:

1. Verify UTG Stand Alone is running.
2. Right click anywhere on the Stand Alone screen, and select **Device Maintenance**.
3. Select the device that needs to be synced and click **Key Exchange**.
   - After you click Key Exchange, the UTG will send a key exchange request to the processor via our data center to obtain new keys.
Configuring Verifone MX P2PE Devices

Configuring Verifone MX915 and MX925 PIN Pad Devices

If you are using Verifone MX P2PE devices, this section will discuss the following:

- Setting up your devices to work with Shift4 and UTG
- Configuration options and settings in UTG
- Collecting information for DOLLARS ON THE NET configuration
- Downloading and modifying Shift4 template forms

The Verifone MX 915/925 devices are capable of reading card swipes (magnetic stripe) and manual card entry as well as contactless/NFC transactions. The Verifone MX 915/925 devices support P2PE, line item display and BIN management. These devices can be connected to UTG via serial, USB, Ethernet or via UTG Stub.

During installation and configuration, the special keys on the Verifone MX 915/925 devices function as follows:

- Enter: select highlighted item
- Clear: backspace
- Cancel: previous screen

Note: You can connect Verifone MX P2PE devices using a serial (RS232) cable with a green connector, a USB cable with a blue connector, or via Ethernet. Ensure the correct cable is used with each initial setting.
Important: Verifone MX P2PE devices do not support swipe ahead, since swipe ahead is not supported with EMV.

Verifone MX P2PE Device Versions Supported and Known Issues

<table>
<thead>
<tr>
<th>Verifone FormAgent</th>
<th>Verifone XPI</th>
<th>OS Version</th>
<th>Description of Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.4.1</td>
<td>5200p</td>
<td>30145200</td>
<td>Forms pushing does not work with serial devices when running OS 30145200. If your devices are serial use OS 30140200 for PCI 3.0 devices and OS 30145100 for PCI 4.0 devices.</td>
</tr>
</tbody>
</table>

To find the FormAgent and XPI software version complete the following steps:

1. With the device displaying the FormAgent screen or one of the idle screens, press and hold the 1, 5 and 9 buttons. The following should be displayed in the order listed:
   - The message “Signal 15 caught”
   - The prompt
   - The menu system.
2. Enter the password for access to the configuration menus.
   - The default password is 166831 but may have been changed.
3. In the menu system, click the Information tab.
4. Click the Installed S/W tab.
5. To find the FormAgent version, look for formAgent under the APPLICATION\[BUNDLES\] column.
   - The version number is displayed in the first column.
6. To find the XPI version look for 01-XPI-App under the APPLICATION\[BUNDLES\] column.

Tip: The password is often changed to 166832.
• The version number is displayed in the first column.

---

Note: The Verifone MX P2PE devices are set to automatically idle on startup, even when UTG is not running. This causes the Retail Base screen to show briefly before idling.

---

OS upgrades can be performed in the field and do not require shipping the device to a special facility. To find the OS version complete the following steps:

1. From the device menu system, select Information > Basic System.
   • The Build number at the bottom contains the OS version.

To find the PCI version of your device complete the following steps:

1. On the back of the device, locate the label pictured below.
   • If the P/N number begins with M132, the device is a PCI 3.0 device.
   • If the P/N number begins with M177, the device is a PCI 4.0 device.

---

Updating to the Latest Version of FormAgent

The latest supported versions of FormAgent/XPI packages can be downloaded using the links below:

• MX915 Package: http://www.shift4.com/downloads/MX915FormAgent.zip
• MX925 Package: http://www.shift4.com/downloads/MX925FormAgent.zip
Since the various version updates must be performed separately, it is important to perform your updates in the following order. This will help avoid having to repeat an update due to overwriting a previous update. For example, if you load your custom forms before you update your FormAgent version, your custom forms will be overwritten by the default forms in the FormAgent package.

1. OS Update
2. FormAgent package update
3. Contactless Firmware update
4. Custom forms

The FormAgent/XPI packages contain the following directories:

1. **Contactless Firmware**: This contains the latest firmware for the contactless readers and must be loaded if contactless will be supported.

2. **FormAgent**: This contains 2 subfolders:
   - **Production**: The files in the Production folder are signed with the Shift4 production certificate.
   - **Test**: The files in the Test folder are signed with the Verifone Development certificate.
   - There are also multiple tgz files in each folder that have the following naming convention:
     - DeviceType-FormAgentVersion-CommunicationType-Environment.
     - For example, the file MX925-FA441-USB-PROD.tgz indicates that the package is for an MX925 device using the production Shift4 certificate that will install FormAgent 4.4.1 and will configure it for USB communication.

   **Note**: These packages also contain Shift4’s default forms, so any time you push one of the update packages to a device, you will have to push your custom forms again.

3. **OS**: This folder contains the updates for the Verifone OS
   - dl.0625orSC1-2-3to30140200-Gen2-PROD.tgz will update the OS to version 30140200
   - dl.3014-to-3145200-B-201500627-PROD.tgz will update from 30140200 to 30145200. **Do not** use this file if you are running serial devices.

   **Note**: Updating the OS version has no effect on any keys that are already loaded on the device.
Working with Verifone Certificates and Shift4 Version Updates

Verifone loads a certificate on each device. Version update packages also contain a certificate. Only update packages signed with the same certificate loaded on the device will work. This is a security feature to protect the devices from someone trying to load malware.

The update packages distributed by Shift4 are signed with a Shift4 certificate. All merchants using Shift4 who order new Verifone MX P2PE devices, should request them with the Shift4 certificate.

If you have existing Verifone MX P2PE devices, they will have a different certificate loaded. You will need to download the version package from the links above, and send the version package to Verifone. Verifone will need to resign the version package with the same certificate that is loaded on the device.

---

**Note:** You should keep all of your devices loaded with the same certificate so that you can easily apply updates when needed.

---

The certificate currently on your device can be located by completing the following steps:

1. From the the device menu, select **Home > Security > Verishield Tree.**
2. Scroll down until you see **Application.** The line below it is the certificate that is loaded.
   - The example below is the certificate used by Shift4 for testing.
   ![Certificate Example](image1)
   - The example below is the Shift4 certificate used for production.
   ![Certificate Example](image2)

If you do not have one of the certificates shown above, you will need to send the version update package to Verifone and have the package signed by Verifone with the same certificate installed on your device.
Locating the Verifone MX P2PE Device Serial Number for DOLLARS ON THE NET®

The serial number on a Verifone MX P2PE device can be located externally and internally. This serial number will be needed by the Administrator to configure the EMV device correctly in DOLLARS ON THE NET. To find the serial number, use one of the methods listed below.

**Locating the Serial On the Back of the Device**

On the back of the device, the serial number you will need to enter in DOLLARS ON THE NET will be the last nine digits of the serial number displayed without the dashes. See the example below.

![Example Serial Number](image)

**Locating the Serial on the Device Screens**

From Verifone MX P2PE device menu, complete the following steps:

- Select the Information tab.
- Select the Basic System tab.
- The serial will be located to the right of the Serial Number field. The dashes should be left out when entering the serial in DOLLARS ON THE NET.

**Verifying Encryption Keys on Verifone MX P2PE Devices**

To verify a P2PE key is injected, complete the following steps:

1. With the device displaying the FormAgent screen or one of the idle screens, press and hold the 1, 5 and 9 buttons. This should display the following in order:
   - The message "Signal 15 caught"
   - The prompt
   - The menu system.
2. Enter the password for access to the configuration menus.
   - The default password is 166831 but may have been changed.

**Tip:** The password is often changed to 166832.
3. In the menu system, click the **Security** tab.
4. Click the **Key Status** tab.
5. Click the **ADE** tab.
6. The Shift4 P2PE key should be displayed in slot 0.

To verify a DUKPT Debit key is injected, complete the following steps:

1. With the device displaying the FormAgent screen or one of the idle screens, press and hold the 1, 5 and 9 buttons. This should display the following in order:
   - The message “Signal 15 caught”
   - The prompt
   - The menu system.
2. Enter the password for access to the configuration menus.
   - The default password is 166831 but may have been changed.

   **Tip:** The password is often changed to 166832.

3. In the menu system click the **Security** tab.
4. Click the **Key Status** tab.
5. Click the **DUKPT** tab.
6. The DUKPT key should be displayed in slot 0.

**Verifone MX System Mode Menu Password**

The default password is 166831 but may have been changed.

**Tip:** The password is often changed to 166832.

**Accessing Verifone MX System Mode Menu**

To access the Verifone MX system menu complete the following steps:
1. With the device displaying the FormAgent screen or one of the idle screens, press and hold the 1, 5 and 9 buttons. This should display the following in order:
   - The message “Signal 15 caught”
   - The prompt
   - The menu system

2. Enter the password for access to the configuration menus.

**Rebooting the Device**

To reboot the Verifone MX P2PE device, complete the following steps:

1. Access the Verifone MX System Mode menu.
2. Click the Reboot button on the Home screen.

**Setting Communication Type**

To verify and set the device communication type, complete the following steps:

1. Access the Verifone MX System Mode menu.
2. Click the Administration tab.
3. Click the Config tab.
4. Click config.usr1.
5. Find the commtype variable and click the value in the column to the right.
   - If the device is connected via serial cable, enter RS232.
   - If the device is connected via Ethernet, enter TCPIP.
   - If the device is connected via USB cable, enter USB.
6. Press the Enter button.

**Setting Serial Communication Parameters**

If your device is set as Serial or USB, you must configure the serial communication parameters. To verify and set device serial communication parameters, complete the following steps:

1. Access the Verifone MX System Mode menu.
2. Click the Administration tab.
3. Click the Config tab.
4. Click config.usr1.
5. Set or verify settings as listed in the following table:

<table>
<thead>
<tr>
<th>MX Series Serial Configuration Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Section</strong></td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>[REG]</td>
</tr>
</tbody>
</table>
### MX Series Serial Configuration Settings

<table>
<thead>
<tr>
<th>Section</th>
<th>Variable</th>
<th>Function</th>
<th>Action Required</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>[REG]</td>
<td>bd</td>
<td>Baud Rate</td>
<td>Set</td>
<td>8</td>
</tr>
<tr>
<td>[REG]</td>
<td>prot</td>
<td>Protocol Format</td>
<td>Set</td>
<td>4</td>
</tr>
</tbody>
</table>

* If using the Serial Port, set the Comm Port according to the label on the Multi Port Connector. If not using the Serial Port, the Comm Port setting is irrelevant.

---

**Requirement:** Entering 8 for the Baud Rate sets the rate of the physical device to 115200. You must also configure the Verifone MX series device in UTG TuneUp or UTG Stub TuneUp with a Baud Rate of 115200.

### Setting Ethernet Communication Parameters

If your device is set as Ethernet, you must configure the Ethernet communication parameters. To verify and set Ethernet communication parameters, complete the following steps:

1. Access the Verifone MX System Mode menu.
2. Click the **Administration** tab.
3. Click the **Config** tab.
4. Click the **Communication** tab.
5. Click the **Network** tab.
6. Click the **Ethernet** tab.
7. Set or verify settings as listed in the following table:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Action Required</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Set</td>
<td>yes</td>
</tr>
<tr>
<td>Mode</td>
<td>Set</td>
<td>StaticIP or DHCP</td>
</tr>
<tr>
<td>IP Address*</td>
<td>Set</td>
<td>IP address</td>
</tr>
<tr>
<td>Netmask*</td>
<td>Set</td>
<td>Subnet Mask</td>
</tr>
<tr>
<td>Gateway*</td>
<td>Set</td>
<td>Default Gateway</td>
</tr>
</tbody>
</table>

* This option is only available if using Static mode. All three values of each octet must be entered, so an IP address of 10.0.1.193 would be entered as 010.000.001.193.

**Requirement:** If you are using DHCP for your Ethernet devices you must ensure that they have a DHCP reservation so they always receive the same IP Address. If the IP Address changes, UTG will not be able to communicate with the device.

8. Click the **Config** tab.

9. Click **config.usr1**.

10. Set or verify settings as listed in the following table:

<table>
<thead>
<tr>
<th>Section</th>
<th>Variable</th>
<th>Function</th>
<th>Action Required</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>[REG]</td>
<td>SERVER</td>
<td>Set the device into TCP server mode</td>
<td>Set</td>
<td>1</td>
</tr>
<tr>
<td>[REG]</td>
<td>TERMPRT</td>
<td>Device listen port</td>
<td>Set</td>
<td>Whatever port you want UTG to connect on. Default is 9001</td>
</tr>
</tbody>
</table>

If an **MX Series Ethernet Configuration Settings** value is present, you can tap the value to change it. If a value is missing, complete the following steps:

1. On the device screen, tap **[reg]**.
2. Tap the Add [reg] var button located in the upper right corner of the screen.

3. Enter the desired Variable from the table above, and press the enter button on the device. This will create a new setting with ~NEW~ as the value.

4. Tap ~NEW~ and enter the desired value.

5. Press the enter button on the device to save the setting.

Other Settings

If you are using UTG Stub, verify that the following settings have been applied on the UTG Stub IP to Serial window:

- Baud Rate: 115200
- Data Bits (Byte Size): 8
- Parity: None
- Stop Bits: 1

**UTG Configuration Settings for Verifone MX915 and MX925 Devices**

Displaying Line Item Details on the PIN Pad

It is possible to display line item details on the Verifone MX P2PE devices. This feature is automatically enabled as long as the POS/PMS supports it and the required forms are loaded on the device. The default forms for the Verifone MX P2PE devices support displaying the line items on the majority of the forms and the line item content is maintained while switching between forms.
Configuring Verifone MX Contactless

The Verifone MX devices have the ability to enable or disable contactless processing. Contactless support is enabled by default. To disable contactless, complete the following steps:

1. In UTG TuneUp, on the Add Device screen, clear **Contactless Enabled** in the Additional Options section.
2. Click **OK**.
3. Click **Save**.
Configuring Verifone MX EBT Support

The Verifone MX devices have the ability to enable or disable Electronic Benefit Transfer (EBT) processing. EBT processing is disabled by default. To enable EBT processing, complete the following steps:

1. In UTG TuneUp, on the Add Device screen, locate and select one or both of the following options:
   - EBT Cash Enabled
   - EBT Food Enabled
2. Click OK.

3. Click Save.

Configuring Verifone MX P2PE Bypass Amount OK

Verifone MX P2PE devices have the ability to enable Bypass Amount OK. If selected, the device will not prompt for amount confirmation.
Configuring Verifone MX Line Length Support

The Verifone MX devices have the ability to wrap text on the List Box elements based on the Line Length setting in UTG TuneUp. UTG will wrap the text at the number of characters specified in the Line Length setting. The default values work best with the default Shift4 forms, however if you change the font or font size on the List Box elements when customizing the forms you will need to adjust this value accordingly.
Verifone MX Source Serial Number Support

The Verifone MX devices have the ability to download card ranges and EMV settings based on the Shift4 serial number under which UTG is configured. You can view the serial number UTG is configured for by clicking the Express tab in TuneUp.

Some merchant's UTGs are configured for a different Shift4 serial number than where the Shift4 merchant ID is set up. If your UTG is configured for the Shift4 serial number where the merchant ID is set up, leave this blank. If the UTG is configured for a different Shift4 serial number, enter the Shift4 serial number where the merchant ID is set up in the Source Serial Number field.
Verifone MX P2PE Tip
UTG TuneUp allows you to configure Tip settings for Verifone MX P2PE devices. If Enable Tip is selected, there are three configuration options to choose from when prompting for a tip:

1. You can prompt for the consumer to enter a tip amount when prompting for a tip by completing the following steps:
   - Select Enable Tip
   - Select No Presets.

2. You can configure preset tip percentages that will be displayed on the device when prompting for a tip by completing the following steps:
   - Select Enable Tip.
   - Select Percent.
   - Enter the desired percentages that will be displayed when prompting for tip.

3. You can configure fixed amount values that will be displayed on the device when prompting for a tip by completing the following steps:
   - Select Enable Tip.
   - Select Amount.
   - Enter the desired amounts that will be displayed when prompting for tip.

---

Note: If Enable Tip is selected, the tip screen will also provide an Other option that allows the consumer to enter a custom tip amount and a No option for no tip that will be displayed on the device.
The example below displays a configuration where tip is enabled, percent is selected, and only three percentages will be displayed when prompting for tip. For more information on configuring this feature, see the UTG *Quick Installation Guide*.

**Note:** Percent and Amount fields are displayed on the device from left to right. Entering a zero in any of the fields will cause that field to not be displayed on the PIN pad. For example, if you select percent and only want to display 3 tip options (10%, 15%, and 20%), you could enter zero in the First Percent field, 10 in the Second Percent field, 15 in the Third Percent field, and 20 in the Fourth Percent field. Only the first three fields would be displayed on the PIN pad.
Verifone MX P2PE Form Flexibility

The Verifone MX P2PE devices provide the merchant the ability to modify the current Verifone PIN Pad forms to match their branding.

Downloading the Shift4 Template Forms for Verifone MX P2PE Devices

To download and extract the Shift4 template forms from the Shift4 website, complete the following steps:

1. Download the template forms for your Verifone MX P2PE device using the links in the table below.

<table>
<thead>
<tr>
<th>For this device...</th>
<th>Download the template forms here...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verifone MX915 P2PE</td>
<td><a href="http://www.shift4.com/downloads/MX915P2PEforms.zip">http://www.shift4.com/downloads/MX915P2PEforms.zip</a></td>
</tr>
<tr>
<td>Verifone MX925 P2PE</td>
<td><a href="http://www.shift4.com/downloads/MX925P2PEforms.zip">http://www.shift4.com/downloads/MX925P2PEforms.zip</a></td>
</tr>
</tbody>
</table>

2. Save the zip file, and extract the files.

Downloading Verifone MX Tools

To download Verifone MX Tools click [http://www.shift4.com/downloads/VerifoneMXTools.zip](http://www.shift4.com/downloads/VerifoneMXTools.zip) to download the zip file and extract the files to a temporary directory.

The files will include the following:

- MX Downloader – Verifone’s tool used to push files to Verifone devices
- MX_FormMgr_3.03B – Verifone’s Form Manager tool used to customize forms
- MX_USB Driver – Verifone’s USB driver
- VeriTar – Verifone’s VeriTar application used to create TGZ files
Using the Verifone MX Downloader to Load the Template Forms

Verifone MX Downloader allows users to load forms onto the Verifone MX devices.

**Requirement:** Close all programs and shut down all services using the Verifone device, including UTG, UTG Stub, and UTG Service before loading forms.

1. Ensure that the PinPad device is displaying the System Information or idle screens.
2. Select **Start > Programs > Verifone > MXDownloader**.
3. Click **MXDownloader**.
4. Click **Browse** and locate the file you want to push to the device.

![MXDownloader 2.8.3](image)
5. Select the Com Port that the device is plugged into and set the Baud Rate to 115200

![Image of MkDownloader 2.8.3 window with Com Port and Baud Rate settings]

6. Select **Send SFL Command**.

![Image of MkDownloader 2.8.3 window with Send SFL Command selected]

7. Click **Send**.
Editing Shift4 Template Forms for Verifone MX P2PE Devices

Verifone devices include editable forms. This allows merchants to add specific wording and logos on individual forms or in the background of every form. Portions of the Shift4 template forms, such as images, button placement, and text placement, can be edited with the Verifone Form Manager.

**WARNING!** Do not change the Control ID for any item or the UTG will not work properly. See the table below for more information.

<table>
<thead>
<tr>
<th>Common Controls</th>
<th>What can be edited?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>Image controls may be changed, deleted, moved, or resized as needed. You may also add images and backgrounds.</td>
</tr>
<tr>
<td>Label</td>
<td>Label controls may be created or moved but existing labels should not be modified or deleted.</td>
</tr>
<tr>
<td>List Box</td>
<td>List Box controls may be moved but should not be renamed, resized, or deleted.</td>
</tr>
<tr>
<td>Button</td>
<td>Button controls may be moved and the image may be changed. Buttons may even be deleted if only the keypad is to be used.</td>
</tr>
</tbody>
</table>
The following table provides names and descriptions of the Shift4 forms for the Verifone MX P2PE devices.

<table>
<thead>
<tr>
<th>Form Name</th>
<th>File Name (Do Not Change)</th>
<th>Form Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount Verification</td>
<td>AMOUNTOK</td>
<td>This displays the amount confirmation screen.</td>
</tr>
<tr>
<td>Advertisement Display</td>
<td>IDLE</td>
<td>When the system is idle it displays this form and cycles through the images in the Idle.eet animation.</td>
</tr>
<tr>
<td>Insert/Swipe Card</td>
<td>INSERTSWIPE</td>
<td>This displays the card entry screen for the cardholder to insert/swipe/tap their card.</td>
</tr>
<tr>
<td>Line Items</td>
<td>LINEITEMS</td>
<td>This is used to display line item detail to the cardholder.</td>
</tr>
<tr>
<td>Message Display</td>
<td>MESSAGE</td>
<td>This is used to display various messages to the cardholder.</td>
</tr>
<tr>
<td>Payment Type Selection</td>
<td>PAYMENTTYPE</td>
<td>This displays the credit/debit/EBT selection screen for non-EMV transactions.</td>
</tr>
<tr>
<td>Prompt Confirmation</td>
<td>PROMPTCONFIRM</td>
<td>This displays the prompt confirmation screen.</td>
</tr>
<tr>
<td>Terms and Conditions Checkbox</td>
<td>TERMS</td>
<td>This displays the terms and conditions screen with an acknowledgement checkbox that must be checked to enable the accept button.</td>
</tr>
<tr>
<td>Signature</td>
<td>SIG</td>
<td>This displays the signature screen for approved transactions.</td>
</tr>
<tr>
<td>Terms and Conditions Signature</td>
<td>TERMSSIG</td>
<td>This displays the terms and conditions signature screen.</td>
</tr>
<tr>
<td>File Transfer</td>
<td>TRANSFER</td>
<td>This displays the file transfer screen that shows percent complete and transfer status.</td>
</tr>
<tr>
<td>Form Name</td>
<td>File Name</td>
<td>Form Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>--------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Input Left</td>
<td>S4INPUTL</td>
<td>This displays the various prompts for input to the cardholder with entry coming from left to right.</td>
</tr>
<tr>
<td>Input Right</td>
<td>S4INPUTR</td>
<td>This displays the various prompts for input to the cardholder with entry coming from right to left.</td>
</tr>
<tr>
<td>Alphanumeric Input Left (Not Password Protected)</td>
<td>S4INPUTAL</td>
<td>This is for alphanumeric keyboard input with left to right input.</td>
</tr>
<tr>
<td>Alphanumeric Input Right (Not Password Protected)</td>
<td>S4INPUTAR</td>
<td>This is for alphanumeric keyboard input with right to left input.</td>
</tr>
<tr>
<td>Alphanumeric Input Left (Password Protected)</td>
<td>S4INPUTALP</td>
<td>This is for alphanumeric keyboard input with left to right password protected input.</td>
</tr>
<tr>
<td>Alphanumeric Input Right (Password Protected)</td>
<td>S4INPUTARP</td>
<td>This is for alphanumeric keyboard input with right to left password protected input.</td>
</tr>
<tr>
<td>Cash Back Selection</td>
<td>CASHBACK</td>
<td>This displays the cash back selection screen.</td>
</tr>
<tr>
<td>PIN Entry</td>
<td>915_FA_PINE</td>
<td>This is for the MX 915 only and prompts the user for PIN entry.</td>
</tr>
<tr>
<td>PIN Entry</td>
<td>925_FA_PINE</td>
<td>This is for the MX 925 only and prompts user for PIN entry.</td>
</tr>
<tr>
<td>Lane Closed</td>
<td>LANECLOSED</td>
<td>The device will display this form when in a lane closed state</td>
</tr>
<tr>
<td>Tip Preset</td>
<td>TIPPRESET</td>
<td>This displays the Tip entry screen with preset percent/amount buttons when enabled.</td>
</tr>
</tbody>
</table>
**UTG Automatic Form Loading and FormAgent/XPI Update**

The UTG has the ability to push new forms or FormAgent/XPI version updates to all compatible devices. This enables merchants to create custom, seasonal, or promotional forms that can be quickly and easily deployed. The supported file extensions UTG will push for Verifone MX P2PE devices include the following:

- .TGZ
- .TAR
- .GZ

To push forms or FormAgent/XPI updates to all compatible devices, complete the following steps:

1. *(If applicable)* For form changes, create a package of forms using the Verifone Form Manager. This file should have a ".TGZ" extension.

2. *(If applicable)* For FormAgent/XPI updates, you should have a file with a ".TGZ" extension. This file must come from Verifone since Verifone has a package signature process that is merchant specific.

3. Copy the ".TGZ" file to `\Shift4\UTG2\Update\Forms\[DeviceType]\` where `[DeviceType]` represents the type of Verifone device. For example: `\Shift4\UTG2\Update\Forms\Verifone MX925 P2PE`. Other device types include the following:
   - Verifone MX915 P2PE

---

**Note:** There should only be one set of forms in the folder. If you have a previous package of forms, make a copy and store in another folder for future use.
4. Create a new text file in the same directory where the package file is placed and name the file `Update.txt`. The `Update.txt` file should not contain any content. It is simply for triggering the update.

5. The UTG will look for an Update.txt file every few seconds while idling. When an Update.txt file is present, the UTG will push the package of forms or FormAgent/XPI update to each of the compatible devices connected to the UTG.

6. The devices will display **Updating Files Please Wait** while the UTG is pushing the package or FormAgent/XPI update to the devices.

7. Once the package of forms or FormAgent/XPI version update has been pushed to all compatible devices, the device will determine whether or not a reboot is necessary.

8. Once the file transfer process is complete, the UTG will verify all the forms have loaded. The message **“Verifying Forms Please Wait”** will be displayed on all compatible devices.
   - If any forms are missing, the UTG will display a message on the device indicating which forms are missing. The missing forms must be added before the device can be used.
   - If all of the forms are present, the UTG will display the idle screens on the devices.

9. The UTG will then delete the Update.txt file.

---

**Pushing Forms/Package Updates to Selected Verifone MX P2PE Devices Using UTG Standalone**

To push forms/package updates to selected Verifone MX P2PE devices, complete the following steps:

1. Complete the first three steps in the **UTG Automatic Form Loading and FormAgent/XPI Update** section.
2. Do not create or include the Update.txt file. Without the Update.txt file, the forms will not automatically load.

3. Place the forms package in the normal update directory.

4. With the UTG Standalone running, right click anywhere on the Standalone screen to display the Device Maintenance window.

5. In the Device Maintenance window, click **Device Maintenance**.

6. From the listed devices, select the desired PIN pads.

7. Click **Push Forms** to push the forms/package updates to the selected PIN pads while the UTG is running.
Using the Verifone Form Manager

To edit the Shift4 template forms in the Verifone Form Manager complete the following steps:

1. From the Verifone Form Manager menu, select **File > Open Application** and select the application to edit, then click **Open**.
2. Double click on the form you want to edit in the APPLICATION FORMS: section on the right side of the Form Manager
3. Modify the images, text placement and button placement as desired.
4. When finished editing, click **Save Forms** to save your changes.
5. Once you have modified all of the forms you intend to modify click **File – Save Application**.
6. From the Verifone Form Manager menu, select **Options > Form decks options….**
7. Clear **Generate Mx8xx Form Deck**.
8. Select **Generate Mx9xx Form Deck** and leave the remaining options as their default.
9. Click **OK**

10. From the Verifone Form Manager menu, select **Generate! Option** to generate the forms package .TGZ file.
11. Load the forms by pushing the ".TGZ" forms package using the steps defined in the *Automatic Form Loading and FormAgent/XPI Update* section above.

**Converting a Verifone MX non-P2PE device to P2PE**

Verifone has the capability to remote key inject devices. This feature can be used to enable P2PE on non-P2PE devices without having to ship them out for key injection. To update a non-P2PE device to P2PE, complete the following steps:

1. Obtain the device serial number for all devices that you want to remote key inject.
2. Contact your Verifone representative and send them the device serial number list.
3. Verifone will return a ".TGZ" remote key injection file.
4. Utilize UTG’s automatic form loading functionality to push the remote key injection file to the device.
5. Reconfigure UTG TuneUp to utilize the Verifone MX915/925 P2PE device type.
**P2PE MSR Devices**

For a complete list of currently supported MSR P2PE devices go to [www.shift4.com](http://www.shift4.com) > DOLLARS ON THE NET > INTEGRATIONS > Third-Party Devices. P2PE MSR devices can be used with or without 4Go. There are no UTG settings for these devices. If you are using 4Go, you will need to select the appropriate settings in DOLLARS ON THE NET on the 4Go Settings page. If you are not using 4Go, you will need to review the API documents at [https://myportal.shift4.com](https://myportal.shift4.com) to verify you are sending the correct data.

**Replacing Inoperable PIN Pads**

Two solutions are available when a PIN pad becomes inoperable during the business day. The first solution requires having a replacement PIN pad device available; the second requires preparing the system with an alternate configuration that does not use a PIN pad, and then switching the system to the alternate configuration if the PIN pad stops operating.

**A Replacement PIN Pad Is Available**

The easiest and fastest method of resolving PIN pad operation issues during the business day is to install a replacement PIN pad. The replacement PIN pad should be the same PIN pad model as the original PIN pad and should be preset for your location.

---

**Note:** If the replacement PIN pad is not preset for your location contact the Shift4 Customer Support team at 702.597.2480, option 2 for further instructions.

---

To replace a dead PIN pad with a replacement PIN pad, complete the following steps:

1. Disconnect the dead PIN pad from the POS.
2. Connect the replacement PIN pad to the POS.
3. Verify the PIN pad's initialization process starts.
4. Verify PIN pad displays the idle sequence after the initialization process finishes.

---

**Note:** In order to process Canadian PIN debit transactions, Debit devices must be configured in DOLLARS ON THE NET. For more information, see the Account Administrator Guide in the Help section of DOLLARS ON THE NET.

---

**Requirement:** Contact the Shift4 Customer Support team at 702.597.2480, option 2, if the PIN pad does not display the idle sequence.
Appendix B – Device Maintenance

The UTG Stand Alone contains a Device Maintenance screen that provides a number of functions for merchants using external devices, such as PIN pads.

To get to the Device Maintenance screen, complete the following steps:
1. In UTG Stand Alone, right click anywhere in the main Stand Alone page.
2. Select Device Maintenance.

The Device Maintenance screen displays any devices that have been configured in UTG and a number of buttons. A description for the use of each button is provided in the table below.

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select All</td>
<td>Selects all displayed devices.</td>
</tr>
<tr>
<td>De-select All</td>
<td>De-selects all displayed devices.</td>
</tr>
<tr>
<td>Key Exchange</td>
<td>Used to resync an Ingenico iPP320 (CAN) device. See the iPP320 Interac Debit Key Exchange section for more information.</td>
</tr>
<tr>
<td>Check Update(s)</td>
<td>Checks the version of selected devices against the version in DOLLARS ON THE NET and downloads an update if needed.</td>
</tr>
<tr>
<td>Button Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Download Now</td>
<td>Used to download device settings configured in DOLLARS ON THE NET or supplied directly from processors as needed.</td>
</tr>
<tr>
<td>Apply Prompts</td>
<td>Used to push the corrected MAC values to selected devices. See the Ingenico iPP320 CAN MAC Values section for more information.</td>
</tr>
<tr>
<td>Verify Forms</td>
<td>Verifies that no Shift4 forms are missing for selected devices.</td>
</tr>
<tr>
<td>Push Forms</td>
<td>Can be used to manually push forms to all similar devices that are selected on the Device Maintenance screen. See the UTG Automatic Form Loading and FormAgent/XPI Update section for more information on both options.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels Device Maintenance screen and returns to the UTG Stand Alone screen.</td>
</tr>
</tbody>
</table>
Using Legacy External Devices with the Universal Transaction Gateway (UTG)

This document is intended for vendors and developers using external devices in their POS/PMS systems. The Universal Transaction Gateway® (UTG®) supports a variety of external devices for transactions processed in the United States and Canada. Device settings and configurations are discussed in this document. It may be necessary to adjust external devices, such as PIN pads, when configuring the UTG or the UTG Stub. PIN pad devices offer a variety of features. For a complete list of supported devices and features, go to [www.shift4.com](http://www.shift4.com) > DOLLARS ON THE NET > INTEGRATIONS > Third-Party Devices.

Configuring Ingenico Devices

*Configuring Ingenico 3070*

**Requirement:** Verify that UPOS Interface Application displays on the Ingenico 3070 screen on boot-up. If the version information is not displayed, contact the Shift4 Customer Support team at 702.597.2480, option 2.
Changing the Baud Rate
To change the Ingenico 3070 baud rate, complete the following steps:

5. To restart the device, disconnect and reconnect the power cord.
6. Simultaneously press and hold the 1, Cancel, and Enter buttons.
7. Select the Supervisor menu. Contact the Shift4 Customer Support team at 702.597.2480, option 2 for the default password.
8. Select Sys Parameters.
9. Select Setup Port and select the correct port number.
10. Select the baud rate. Shift4 recommends a baud rate of 19200.
11. When finished, press the Cancel button until the device restarts.

Other Settings
Verify that the following settings have been applied on the UTG Stub IP to Serial window:

- Data Bits (Byte Size): 8
- Parity: None
- Stop Bits: 1
- Flow Control: None

Requirement: You must load the Shift4 template forms on the Ingenico 3070 device. Refer to the sections regarding forms for Ingenico Devices in this document.

Configuring Ingenico i6550
During installation and configuration, the keypad special keys function as follows:

- Plus (+): scroll up
- Minus (-): scroll down
- Enter: select highlighted item
- Cancel: previous screen
- Any button enables backlight
Requirement: Verify that UPOS Interface Application, Version 2.10, Kernel 2.77, SSA 02.12, MNT 01.26 displays on the Ingenico i6550 screen on boot-up. If the version information is not displayed, contact the Shift4 Customer Support team at 702.597.2480, option 2.

Booting the Device
To boot the Ingenico i6550, complete the following steps:

12. Simultaneously press and hold the 1, 3, Cancel, and Enter buttons and then release.

13. To open the SSA System menu, press and hold the Clear button. During boot-up the device beeps and startup routines flash briefly on the screen.


15. On the Configuration Ticket menu, select App Ticket.

16. On the Application Config screen, verify the following applications are loaded on the device in the Application List section:
   - CA0300_IBMEF (#3)
   - US0901_UIA__ (#9)

17. To return to the SSA System menu, press the Cancel button twice.

Verifying Device Settings
Device settings are nested several levels beneath the SSA System menu. To verify and set device parameters, complete the following steps:

18. From the SSA System menu, select the Extended menu.

19. From the Extended menu, select the Supervisor menu. This menu is password protected. Contact the Shift4 Customer Support team at 702.597.2480, option 2 for the default password.

20. To open and set the Supervisor menu options, type the password and the following settings:
   - Select Sys Parameters
- Select **Setup Port**
- Select **Port 1**
- Set or verify port settings as listed in the following table:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Action Required</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Type</td>
<td>Set</td>
<td>RS232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>Set</td>
<td>19200</td>
</tr>
<tr>
<td>Data Bits</td>
<td>Set</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>Set</td>
<td>1</td>
</tr>
<tr>
<td>Parity</td>
<td>Set</td>
<td>None</td>
</tr>
<tr>
<td>LAN Address</td>
<td>Verify</td>
<td>101</td>
</tr>
<tr>
<td>Retry Count</td>
<td>Verify</td>
<td>3</td>
</tr>
<tr>
<td>Response TMO</td>
<td>Verify</td>
<td>1000</td>
</tr>
<tr>
<td>Poll TMO</td>
<td>Verify</td>
<td>3000</td>
</tr>
<tr>
<td>Turnaround TMO</td>
<td>Verify</td>
<td>300</td>
</tr>
</tbody>
</table>

21. Press the **Cancel** button until the Configuration menu returns.

**Other Settings**

Verify that the following settings have been applied on the UTG Stub IP to Serial window:

- Data Bits (Byte Size): 8
- Parity: None
- Stop Bits: 1
- Flow Control: None

---

**Requirement:** You must load the Shift4 template forms on the Ingenico i6550 device. Refer to the **Loading Shift4 Template Forms on Ingenico Devices** section in this document.
Configuring Ingenico i6780

During installation and configuration, the keypad special keys function as follows:

- Plus (+): scroll up
- Minus (-): scroll down
- Enter: select highlighted item
- Cancel: previous screen
- Any button enables backlight

**Requirement:** Verify that UPOS Interface Application, Version 2.32, Kernel 2.86, SSA 02.51, MNT 01.30 displays on the Ingenico i6780 screen on boot up. If the version information is not displayed, contact the Shift4 Customer Support team at 702.597.2480, option 2.

Booting the Device

To boot the Ingenico i6780, complete the following steps:

22. Simultaneously press and hold the 1, 3, Cancel, and Enter buttons and then release.

23. To open the SSA System menu, press and hold the Clear button. During boot-up the device beeps and startup routines flash briefly on the screen.

24. On the SSA System menu, select Configuration Ticket.

25. On the Configuration Ticket menu, select App Ticket.

26. On the Application Config screen, verify the following applications are loaded on the device in the Application List section:
   - CA0300_IBMEF (#3)
   - US0901_UIA__ (#9)

27. To return to the SSA System menu, press the Cancel button twice.
Verifying Device Settings

Device settings are nested several levels beneath the SSA System menu. To verify and set device parameters, complete the following steps:

28. From the SSA System menu, select the **Extended** menu.

29. From the Extended menu, select the **Supervisor** menu. This menu is password protected. Contact the Shift4 Customer Support team at 702.597.2480, option 2 for the default password.

30. To open and set the Supervisor menu options, enter the password and complete the following steps:
   
   - Select **Sys Parameters**
   - Select **Setup Port**
   - Select **Port 1**
   - Set or verify port settings as listed in the following table:

### Ingenico 6780 Configuration Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Action Required</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Type</td>
<td>Set</td>
<td>RS232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>Set</td>
<td>19200</td>
</tr>
<tr>
<td>Data Bits</td>
<td>Set</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>Set</td>
<td>1</td>
</tr>
<tr>
<td>Parity</td>
<td>Set</td>
<td>None</td>
</tr>
<tr>
<td>LAN Address</td>
<td>Verify</td>
<td>101</td>
</tr>
<tr>
<td>Retry Count</td>
<td>Verify</td>
<td>3</td>
</tr>
<tr>
<td>Response TMO</td>
<td>Verify</td>
<td>1000</td>
</tr>
<tr>
<td>Poll TMO</td>
<td>Verify</td>
<td>3000</td>
</tr>
<tr>
<td>Turnaround TMO</td>
<td>Verify</td>
<td>300</td>
</tr>
</tbody>
</table>

31. Press the **Cancel** button until the Configuration menu returns.

Other Settings

Verify that the following settings have been applied on the UTG Stub IP to Serial window:

- Data Bits (Byte Size): 8
- Parity: None
- Stop Bits: 1
Flow Control: None

Requirement: You must load the Shift4 template forms on the Ingenico i6780 device. Refer to the sections regarding forms for Ingenico devices in this document.
Setting the Coordinates File for i6550 and i6780 in TuneUp

If you are using an Ingenico i6550 or i6780 and you want to change the position where totals, sub totals, or tip should print on the form, you must customize and specify a Coordinates File by doing the following:

3. Under the Devices tab, select the PIN Pad and then, click the Edit button.
4. Click Browse.

The following message appears.

5. Select the desired Coordinates File. A default Coordinates File should have been downloaded with the Shift4 forms. Each device will have its own coordinates file. An example file with field explanations is provided below the screenshot.
* Ingenico Pin Pad Coordinates File
* 
* This file is used to set custom X,Y coordinates for text fields on various
* Ingenico pin pad devices.
* Any line beginning with an asterisk (*), such as this one, is a comment.
* All other lines consist of four fields, comma separated.
* 
* Field 1 is the screen number
* Field 2 is the precise field on the screen. Some screens have only one, others
* have several.
* Field 3 is the X coordinate you want the field displayed at.
* Field 4 is the Y coordinate you want this field displayed at.
* 
* For example the line "6,Total,75,50" means that for screen 6, display the Total
* field at X coordinate 75, and Y coordinate 50.
* 
* If Field 1 is not a digit, it will flag an error, and all X,Y coordinates will be
* restored to default values.
* 
* If you wish to use the default value for one of the X or Y coordinates, you may
* leave that field blank in the line.
* For example a line like 6,Total,,100 will use the default value for the X
* coordinate, and set the Y coordinate to 100.
* If you wish to use default values for both coordinates, you can simply delete the
* corresponding line, or comment it out by putting an asterisk (*) at the beginning
* of it.
* 
* Screen Number, Field, X, Y
6,Subtotal,165,15
6,Tip,165,45
6,Total,165,75
7,Amount,120,20
11,Amount,200,60
Configuring Ingenico iPP320 [U.S.]/350 & Touch iSC250/350/480 Telium UIA Devices

The Ingenico iPP320 [U.S.] and iPP350 offer keypad and multiple card reader functionalities.

Note: The iPP320 CAN device is not part of this Telium group and is described with features and settings in the Ingenico iPP320 CAN section.

The Ingenico Touch iSC250, iSC350, and iSC480 offer keypad, multiple card reader, signature capture, and touch screen functionality. The iSC250 can also be purchased as, or converted to be used as a point-to-point encryption (P2PE) device, and can connect to the UTG using TCP/IP. The Touch iSC250/350/480 and iPP320 [U.S.]/350 are capable of reading card swipes (magnetic stripe) and an optional contactless card reader. All Telium devices support BIN management, including P2PE devices. During installation and configuration, the keypad special keys function as follows:

- Plus (+) or Arrow Up: scroll up
- Minus (-) or Arrow Down: scroll down
- Enter: select highlighted item
- Cancel or Clear: previous screen
- Any button enables backlight
Note: These devices run on UPOS Interface Application (UIA). The version information is displayed on the device on boot up.

### Ingenico Telium Devices UIA Versions Supported and Known Issues

<table>
<thead>
<tr>
<th>Ingenico Firmware</th>
<th>Supported?</th>
<th>P2PE Supported?</th>
<th>Description of Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telium UIA 1.5</td>
<td>No</td>
<td>No</td>
<td>Ingenico forms do not allow leading zeros in the ‘Enter Exp Date’ and ‘Enter Card Number’ prompts. This prevents use of manual card entry.</td>
</tr>
<tr>
<td>Telium UIA 1.6</td>
<td>Yes</td>
<td>No</td>
<td>Ingenico forms do not allow leading zeros in the ‘Enter Card Number’ prompt.</td>
</tr>
<tr>
<td>Telium UIA 2.2</td>
<td>Yes</td>
<td>No</td>
<td>No known issues.</td>
</tr>
<tr>
<td>Ingenico Firmware</td>
<td>Supported?</td>
<td>P2PE Supported?</td>
<td>Description of Issue</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>----------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Telium UIA v3.3.1.3001</td>
<td>Yes</td>
<td>Yes</td>
<td>No known issues. Note: New forms may be needed. When manual card entry is set to optional:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To skip Card Security Code (CVV2) and Expiration Date, press the Cancel button instead of the Enter button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To skip the Street Number and Postal Code, use the Enter button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To skip all other manual card entry screens use the Enter button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• A card number entered on the MCE screen must be at least 12 digits.</td>
</tr>
<tr>
<td>Telium UIA 6.0.1.0149</td>
<td>Yes</td>
<td>Yes</td>
<td>Only tested on the Touch iSC480.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• A card number entered on the MCE screen must be at least 12 digits.</td>
</tr>
<tr>
<td>Telium UIA 8.0.12</td>
<td>Yes</td>
<td>Yes</td>
<td>Works with iSC devices only. This version fixed an Apple Pay issue with MasterCard.</td>
</tr>
<tr>
<td>Telium UIA 9.0.4</td>
<td>Yes</td>
<td>Yes</td>
<td>No known issues.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To skip Card Security Code (CVV2) and Expiration Date, press the Cancel button instead of Enter button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To skip the Street Number and Postal Code use the Enter button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To skip all other manual card entry screens use the Enter button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• A card number entered on the MCE screen must be at least 12 digits.</td>
</tr>
</tbody>
</table>
To find the UIA version on the Telium device, complete the following steps:

1. Verify the UTG is not running
2. Press the **Clear** and **Minus (-)** buttons simultaneously. This power cycles the device.
3. The UIA version is visible on boot up.

Access TSA System Menu

To access the TSA system menu, complete the following steps:

32. Reboot the device:
   - Touch iSC250/350/480: Simultaneously press and hold the **Clear** and **Minus (-)** buttons and then release. During boot-up, the device beeps and startup routines flash briefly on the screen.
   - iPP320 [U.S.]/350: Simultaneously press and hold the **Clear** and **Period (.)** buttons and then release. During boot-up, the device beeps and startup routines flash briefly on the screen.

33. To open the TSA System menu:
   - Touch iSC250/350/480: Press **2, 6, 3, 4, Enter** and then the **Plus (+)** button.
   - iPP320 [U.S.]/350: Press **2, 6, 3, 4, Enter** and then the **F** button.

Verifying Device Settings

To verify and set device parameters:

34. From the TSA System menu, select the **TDA** menu.
35. From the TDA menu, select **0 – Configuration, 0 - Communication** and then, **0 – Select Comm. Type**.
• If the device is connected via serial cable select 0 – Serial.
• If the device is connected via USB cable select 3 – USB<>Serial Conv.

36. Press the Cancel/Clear button and then, 1 – Serial Settings.
37. Set or verify settings as listed in the following table:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Action Required</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate</td>
<td>Set</td>
<td>115200</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>Set</td>
<td>1</td>
</tr>
<tr>
<td>Bits per Byte</td>
<td>Set</td>
<td>8</td>
</tr>
<tr>
<td>Parity</td>
<td>Set</td>
<td>None</td>
</tr>
<tr>
<td>Flow Control</td>
<td>Set</td>
<td>None</td>
</tr>
</tbody>
</table>

38. Press the Cancel/Clear button until the Configuration menu returns.

**Other Settings**

If you are using a UTG Stub, verify that the following settings have been applied on the UTG Stub IP to Serial window:

- Data Bits (Byte Size): 8
- Parity: None
- Stop Bits: 1

**Requirement:** You must load the Shift4 template forms on the devices. Refer to the sections regarding forms for Ingenico devices in this document.
Displaying Line Item Details on the PIN Pad

It is possible to display line item details on the Ingenico series devices. This feature is automatically enabled as long as the POS/PMS supports it and the required forms are loaded on the PIN pad.

Ingenico Form Flexibility

New functionality provides the merchant the ability to change the current Ingenico PIN Pad forms on i6550, i6780, iPP320 [U.S.]/350 and iSC250/350/480 models. This includes being able to move the current static placement of buttons on the following screens:

- Signature capture screen
- Amount screen
- Tip screen
- Amount with tip screen

Loading Shift4 Template Forms on Ingenico Devices

You must load Shift4 template forms on the following Ingenico devices in order to incorporate and display greeting, input, and error information associated with transactions:

- Ingenico 3070
- Ingenico i6550
- Ingenico i6780

Requirement: Before you can load the template forms, the Ingenico OPOS driver and Ingenico Form Designer application must be installed on the computer you will use to communicate with the Ingenico device. This need not be the same computer where the UTG or UTG Stub is installed.

Both the OPOS driver and the Form Design application are Ingenico products. Contact Ingenico for the installation files and installation instructions.

Refer to the Ingenico documentation for information about how to install the OPOS driver and the Form Designer application.

Note: Contact Ingenico if you have questions about installing the OPOS driver or Form Designer.
Configuring the Ingenico OPOS

After you have installed the Ingenico OPOS driver and the Ingenico Form Designer application, you must configure the Ingenico OPOS device to ensure successful communication between the Ingenico Form Designer and the device where you are installing the Shift4 forms. The Ingenico OPOS utility differs depending on which Ingenico device you are using.

Configuring Ingenico 3070 iSeries OPOS

To configure the Ingenico iSeries OPOS complete the following steps:

39. From the Start menu, select Programs > Ingenico > OPOS for the Ingenico iSeries > Ingenico iSeries Setup.

40. In the Ingenico iSeries OPOS Configuration window, on the General tab in the Device Connection section, select the following required settings:
   • From the Device Connection Type list, select Serial Port.
   • From the Comm Port list, select the communications port for the Ingenico Form Designer to use to communicate with the Ingenico device.
   • From the Baud Rate list, select the baud rate configured on the device (usually 19200).
   • From the Byte Size list, select 8.
   • From the Parity list, select None.
   • From the Stop Bits list, select 1.
   • Allow all other settings to default.
41. Click **OK**.
Configuring Ingenico 6XXX OPOS

To configure the Ingenico 6XXX OPOS, complete the following steps:

42. From the Start menu, select Programs > Ingenico > Ingenico 6XXX Toolkit > OPOS - Ingenico 6XXX Setup.

43. Click the OPOS - Ingenico 6XXX Setup application.

44. In the Ingenico 6XXX OPOS Configuration window, under Special Features of Ingenico 6XXX, select a Device Model.

45. Under Device Connection, configure the following:
   - From the Device Connection Type list, select Serial Port.
   - From the Comm Port list, select a communications port for the Ingenico Form Designer to use to communicate with the Ingenico device.
   - From the Baud Rate list, select 19200.
   - From the Byte Size list, select 8.
   - From the Parity list, select None.
   - From the Stop Bits list, select 1.

46. Click OK.
Downloading the Shift4 Template Forms for Ingenico Devices

To download and extract the Shift4 template forms, use the links in the table below.

47. Download the template forms for your Ingenico device from the Shift4 website:

<table>
<thead>
<tr>
<th>For this device...</th>
<th>Download the template forms here...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ingenico 3070</td>
<td><a href="http://www.shift4.com/downloads/i3070forms.zip">http://www.shift4.com/downloads/i3070forms.zip</a></td>
</tr>
<tr>
<td>Ingenico i6550</td>
<td><a href="http://www.shift4.com/downloads/i6550forms.zip">http://www.shift4.com/downloads/i6550forms.zip</a></td>
</tr>
<tr>
<td>Ingenico i6780</td>
<td><a href="http://www.shift4.com/downloads/i6780forms.zip">http://www.shift4.com/downloads/i6780forms.zip</a></td>
</tr>
<tr>
<td>Ingenico iSC480™</td>
<td><a href="http://www.shift4.com/downloads/iSC480forms.zip">http://www.shift4.com/downloads/iSC480forms.zip</a></td>
</tr>
</tbody>
</table>

48. Save the zip file.

49. Extract the files:
   - Open the zip file and click Extract.
   - In the Extract window, navigate to the folder where you want to save the template forms.
   - Select All Files and click Extract to unzip the files.
Using the Ingenico Form Designer to Load the Template Forms

The Ingenico Form Designer allows users to load, edit, and test forms displayed by the Ingenico devices.

**Requirement:** Close all programs and shut down all services using the Ingenico device, including UTG, UTG Stub, and UTG Service before loading forms.

To load Shift4 template forms on the Ingenico device, complete the following steps:

50. Connect the Ingenico device to the computer where you extracted the forms.

51. From the Start menu select Programs > Ingenico > Form Designer > Form Designer Application to open the Ingenico Form Designer.

52. In the Form Type Configuration window, specify the target device and application:
   - From the Device Name list, select your Ingenico device.
   - From the Target App list, select **UPOS Apps (UIA, eN-Cmd)**.
   - Click **OK**.

53. In the Ingenico Form Designer, open a template form:
   - Select **File > Open**....
   - Navigate to the directory where you extracted the Shift4 template forms.
   - Select a template form file. The file extension for Ingenico devices is .ICG.
   - Click **Open**.

**Note:** The Shift4 template images are black and white. If you are opening the templates on a color device, you may see a warning message. Ignore the warning and open the template form.

54. In the Ingenico Form Designer, load the template form on the device:
   - Select **Form > Test Form On Device**...
   - Before loading the first form only, click **Clear All Forms on Device**.

**Note:** To avoid having to start over, be careful not to click the **Clear All Forms on Device** button again during the process.

- Click **Store The Current Form on the Device**.
55. For each additional form, repeat steps 4 and 5, but do not click **Clear All Forms on Device**.

---

**Note:** If you encounter an error when attempting to store, verify that all device cables are secure.

---

**Editing Shift4 Template Forms for Ingenico Devices**

Several of the UTG-compatible devices include editable forms. This allows merchants to add specific wording and logos on individual forms or in the background of every form. Follow the instructions provided by the device manufacturer.

Portions of the Shift4 template forms can be edited with either the Ingenico Form Designer or any graphics editor, depending on the changes to be made to the form. The Ingenico i6550 is shown.

---

**Note:** You can edit black text by opening the .bmp file in any graphics editor.
WARNING! Do not alter the layout of the form. Do not delete buttons on the form. Only the graphics and the text can be altered.

The following table provides descriptions for the Shift4 forms or file names.

<table>
<thead>
<tr>
<th>Form Number</th>
<th>Form Name (Screen Image)</th>
<th>File Name (DO NOT CHANGE)</th>
<th>Form Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form 1</td>
<td>MainScreen (Main Screen)</td>
<td>Z1-MAIN</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>Form 2</td>
<td>IdleScreen1 (IDLE SCREEN 1)</td>
<td>Z2-IDL_1</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>Form Number</td>
<td>Form Name (Screen Image)</td>
<td>File Name (DO NOT CHANGE)</td>
<td>Form Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------</td>
<td>---------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Form 3</td>
<td>IdleScreen2 (IDLE SCREEN 2)</td>
<td>Z3-IDL_2</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>Form 4</td>
<td>IdleScreen3 (IDLE SCREEN 3)</td>
<td>Z4-IDL_3</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>Form 5</td>
<td>PleaseWait (Please Wait...)</td>
<td>Z5-PlsWt</td>
<td>Customer is waiting for system to process.</td>
</tr>
<tr>
<td>Form 6 (Used with customer tip entry)</td>
<td>FBAmount</td>
<td>Z6-FBAmt</td>
<td>Ticket amount, Tip amount, and Total amount will be shown. Customer to accept the amount, change the tip amount, or cancel the transaction.</td>
</tr>
<tr>
<td>Form 7 (Used without customer tip entry)</td>
<td>AmountOK</td>
<td>Z7-AmtSc</td>
<td>Total amount will be shown. Customer to accept the amount or cancel the transaction.</td>
</tr>
<tr>
<td>Form 8</td>
<td>SelectCardType (Please select the Card Type)</td>
<td>Z8-CdTyp</td>
<td>Customer to select the card type.</td>
</tr>
<tr>
<td>Form 9</td>
<td>SlideCard (PLEASE SWIPE CARD)</td>
<td>Z9-SCard</td>
<td>Customer to swipe card.</td>
</tr>
<tr>
<td>Form 10</td>
<td>PleaseResign (Please re-sign)</td>
<td>Z10-Rsgn</td>
<td>System unable to read signature. Customer must re-sign signature.</td>
</tr>
<tr>
<td>Form Number</td>
<td>Form Name (Screen Image)</td>
<td>File Name (DO NOT CHANGE)</td>
<td>Form Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------</td>
<td>---------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Form 11</td>
<td>SignBelow (Please Sign Below)</td>
<td>Z11-Sign</td>
<td>Transaction was approved. Customer to enter signature then click <strong>Accept</strong>. Click <strong>Clear</strong> to reset signature field. Click <strong>Cancel</strong> to exit screen without signature.</td>
</tr>
<tr>
<td>Form 12</td>
<td>Approved (APPROVED)</td>
<td>Z12-Aprv</td>
<td>Transaction was approved.</td>
</tr>
<tr>
<td>Form 13</td>
<td>Declined (DECLINED)</td>
<td>Z13-Decl</td>
<td>Transaction was declined.</td>
</tr>
<tr>
<td>Form 14</td>
<td>Referral (Your transaction was not approved. Please see cashier.)</td>
<td>Z14-Refl</td>
<td>Merchant required to call for voice authorization.</td>
</tr>
<tr>
<td>Form 15</td>
<td>NotProc (Unable to process transaction. Your card has not been charged.)</td>
<td>Z15-NoPr</td>
<td>Shift4 was unable to process the transaction. The transaction did not go through and the customer’s credit card was not charged.</td>
</tr>
<tr>
<td>Form 16</td>
<td>ApprovedPleaseSign (Your transaction was approved. Please sign draft.)</td>
<td>Z16-ApSn</td>
<td>Transaction was approved. Customer to sign the receipt draft.</td>
</tr>
</tbody>
</table>
**Requirement:** The Ingenico Forms folder contains two sets of forms: .ic* and .bmp. Forms ending with .ic*, can be edited using the Form Designer. Forms ending with .bmp, can be edited using any graphics software.

---

**Using the Ingenico Form Designer**

Any text displayed in blue when viewing the form in the Ingenico Form Designer can be modified. The Ingenico i6550 Text Box is shown. To edit the Shift4 template forms in the Form Designer:

56. In the Form Designer window, open the *.ic* file of the form to be edited.
57. Double-click the text to be edited.
58. Complete the text edits.
59. Click **OK**.

60. Click **Save**.
Using Graphics Software

Any text displayed in black when viewing the form in the Form Designer can be modified in any graphics editor. To edit the Shift4 template forms in your graphics editor, complete the following steps:

61. In your graphics software, open the *.bmp file of the form to be edited.
62. Edit the form according to device constraints listed in the following table:

<table>
<thead>
<tr>
<th>Devices</th>
<th>B/W*</th>
<th>Color</th>
<th>Dimensions (pixels)</th>
</tr>
</thead>
<tbody>
<tr>
<td>i6550</td>
<td>X</td>
<td></td>
<td>322 x 240</td>
</tr>
<tr>
<td>i6780</td>
<td></td>
<td>X</td>
<td>320 x 234</td>
</tr>
<tr>
<td>3070</td>
<td>X</td>
<td></td>
<td>50 x 30</td>
</tr>
</tbody>
</table>

**WARNING!** Do not add color to forms used on black and white devices. Color forms will not run on black and white devices.

63. Click **Save**.

Verifying Edited Forms

After editing the forms, complete the following steps:

64. If you used graphics software, open the edited file in the Form Designer.
65. On the Ingenico Form Designer window Form menu, select **Test Current Form on Device**.
66. To store the form, click **Store the Current Form on the Device**.
67. To display the form, click **Display the Current Form on the Device**.
68. When finished, click **Done**.
Using the Ingenico Local Load Tool (LLT) to Load the Template Forms

The Local Load Tool (LLT) allows users to load forms onto the Ingenico TELIUM devices.

Requirement: Close all programs and shut down all services using the Ingenico device, including UTG, UTG Stub, and UTG Service before loading forms.

69. Set the PIN pad into the LLT mode by completing the following steps:
   • Touch iSC250/350/480: reboot the PIN pad holding the minus (-) button while it boots up.
   • iPP320 [U.S.]/350: reboot the PIN pad continuously press the F button until a menu appears. Select Download then Local Download. The PIN pad screen will display LLT.

70. Select Start > Programs > TELIUM Tools > LLT 4.4 (this version number may vary depending on your download).

71. Click LLT 4.4.

72. To configure LLT to connect to the correct COM Port, see the LLT User Guide.pdf for instructions. It should be located in the Telium Utilities folder.

73. Select Terminal > Connection.

74. In the All directories pane (left side), select the folder where you extracted the Ingenico devices forms.

75. From the drop-down list (above the middle) pane, select *. This will display all of the forms in the middle pane.

76. Verify that the drop-down list above the Terminal view pane displays *:* to view all files on the PIN Pad.

77. In the Terminal view pane (right side), click the Up folder until you reach the top level.

78. Double click HOST.

79. Select all files in the middle pane and drag them into the Terminal view pane.
80. Select Terminal > Disconnect. The PIN pad should automatically reboot.

**Editing Shift4 Template Forms for Ingenico Telium Devices**

Ingenico devices include editable forms. This allows merchants to add specific wording and logos on individual forms or in the background of every form. Portions of the Shift4 template forms, such as images, button placement, and text placement, can be edited with the Telium Form Builder.

---

**WARNING!** Do not change the Attribute ID for any item or the UTG will not work properly. See the table below for more information.

---

<table>
<thead>
<tr>
<th>Common Controls</th>
<th>What can be edited?</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCTT ctt</td>
<td>CCTT ctt controls may be moved but the text and control size should not be changed.</td>
</tr>
<tr>
<td>Image image</td>
<td>Image image controls may be changed, deleted, moved, or resized as needed. You may also add images and backgrounds.</td>
</tr>
<tr>
<td>Label lbl</td>
<td>Label lbl controls may be created, modified, deleted, or moved.</td>
</tr>
<tr>
<td>LineDisplay linedisplay</td>
<td>LineDisplay linedisplay controls may be moved but should not be renamed, resized, or deleted.</td>
</tr>
<tr>
<td>Bmp Button</td>
<td>Bmp Button controls may be moved and the image may be changed. Bmp Buttons may even be deleted if only the keypad is to be used.</td>
</tr>
</tbody>
</table>
### Common Controls

<table>
<thead>
<tr>
<th>What can be edited?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signature sig</td>
</tr>
<tr>
<td>Signature sig may not be changed, moved, or resized. However, the background color, ink color, and pen size may be changed.</td>
</tr>
<tr>
<td>PINEntry pinentry controls may be moved but not resized and the text must NOT be changed.</td>
</tr>
</tbody>
</table>

![Diagram of Common Controls](image)
The following table provides descriptions for the Shift4 forms or file names for the Ingenico Telium devices.

<table>
<thead>
<tr>
<th>Form Name (Screen Image)</th>
<th>File Name (Do Not Change)</th>
<th>UIA Version</th>
<th>Form Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MainScreen (Main Screen)</td>
<td>zMAIN1.K3Z</td>
<td>All</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>IdleScreen1 (IDLE SCREEN 1)</td>
<td>z2IDL1.K3Z</td>
<td>All</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>IdleScreen2 (IDLE SCREEN 2)</td>
<td>z3IDL2.K3Z</td>
<td>All</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>IdleScreen3 (IDLE SCREEN 3)</td>
<td>z4IDL3.K3Z</td>
<td>All</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>PleaseWait (Please Wait...)</td>
<td>z5PLE1.K3Z</td>
<td>All</td>
<td>Customer is waiting for system to process.</td>
</tr>
<tr>
<td>FBAmount</td>
<td>z6FBA4.K3Z</td>
<td>All</td>
<td>Ticket amount, tip amount, and total amount will be shown. Customer to accept the amount, change the tip amount, or cancel the transaction.</td>
</tr>
<tr>
<td>AmountOK</td>
<td>z7AMT1.K3Z</td>
<td>All</td>
<td>Total amount will be shown. Customer to accept the amount or cancel the transaction.</td>
</tr>
<tr>
<td>SelectCardType (Please select the Card Type)</td>
<td>z8SCT2.K3Z</td>
<td>All</td>
<td>Customer to select the card type.</td>
</tr>
<tr>
<td>SlideCard (PLEASE SWIPE CARD)</td>
<td>z9SCard.K3Z</td>
<td>All</td>
<td>Customer to swipe card.</td>
</tr>
<tr>
<td>Form Name</td>
<td>File Name</td>
<td>UIA Version</td>
<td>Form Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PleaseResign (Please re-sign)</td>
<td>z10Rsgn.K3Z</td>
<td>All</td>
<td>System unable to read signature. Customer must re-sign signature. Note: This form is only used on the iSC250/350/480 devices.</td>
</tr>
<tr>
<td>SignBelow (Please Sign Below)</td>
<td>z11SI2.K3Z</td>
<td>All</td>
<td>Transaction was approved. Customer to enter signature then click Accept. Click Clear to reset signature field. Click Cancel to exit screen without signature. Note: This form is only used on the iSC250/350/480 devices.</td>
</tr>
<tr>
<td>Approved (APPROVED)</td>
<td>z12Aprv.K3Z</td>
<td>All</td>
<td>Transaction was approved.</td>
</tr>
<tr>
<td>Declined (DECLINED)</td>
<td>z13Decl.K3Z</td>
<td>All</td>
<td>Transaction was declined.</td>
</tr>
<tr>
<td>Referral (Your transaction was not approved. Please see cashier.)</td>
<td>z14Refl.K3Z</td>
<td>All</td>
<td>Merchant required to call for voice authorization.</td>
</tr>
<tr>
<td>NotProc (Unable to process transaction. Your card has not been charged.)</td>
<td>z15NoPr.K3Z</td>
<td>All</td>
<td>Shift4 was unable to process the transaction. The transaction did not go through and the customer’s credit card was not charged.</td>
</tr>
<tr>
<td>ApprovedPleaseSign (Your transaction was approved. Please sign draft.)</td>
<td>z16ApSn.K3Z</td>
<td>All</td>
<td>Transaction was approved. Customer to sign the receipt draft.</td>
</tr>
<tr>
<td>Enter New Amount</td>
<td>z17ManAmt.K3Z</td>
<td>Prior to UIA v3 x</td>
<td>Displays after clicking change Tip Amount. Enter new Tip Amount.</td>
</tr>
<tr>
<td>Enter New Amount</td>
<td>a17ManAmt.K3Z</td>
<td>UIA v3.x and above</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>Form Name (Screen Image)</td>
<td>File Name (Do Not Change)</td>
<td>UIA Version</td>
<td>Form Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Line Item Detail</td>
<td>z18Lineltms.K3Z</td>
<td>All</td>
<td>Form for displaying line item details.</td>
</tr>
<tr>
<td>Enter Card Number</td>
<td>z31ManCard.K3Z</td>
<td>Prior to UIA v3 x</td>
<td>Cardholder to enter Card Number.</td>
</tr>
<tr>
<td>Enter Card Number</td>
<td>a31ManCard.K3Z</td>
<td>UIA v3.x and above</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>Enter Expiration Date</td>
<td>z32ManExpD.K3Z</td>
<td>All</td>
<td>Cardholder to enter Expiration Date. Leave blank and press <strong>Cancel</strong> to bypass entry.</td>
</tr>
<tr>
<td>Enter CVV or CID from card</td>
<td>z33ManCVV.K3Z</td>
<td>Prior to UIA v3 x</td>
<td>Cardholder to enter CVV or CID from card. Leave blank and press <strong>Enter</strong> to bypass entry.</td>
</tr>
<tr>
<td>Enter CVV or CID from card</td>
<td>a33ManCVV.K3Z</td>
<td>UIA v3.x and above</td>
<td>Cardholder to enter CVV or CID from card. Leave blank and press <strong>Enter</strong> to bypass entry.</td>
</tr>
<tr>
<td>Enter Zip Code</td>
<td>z34ManZip.K3Z</td>
<td>Prior to UIA v3 x</td>
<td>Cardholder to enter Zip Code. Leave blank and press <strong>Enter</strong> to bypass entry.</td>
</tr>
<tr>
<td>Enter Zip Code</td>
<td>a34ManZip.K3Z</td>
<td>UIA v3.x and above</td>
<td>Cardholder to enter Zip Code. Leave blank and press <strong>Enter</strong> to bypass entry.</td>
</tr>
<tr>
<td>Enter Street Number</td>
<td>z35ManStre.K3Z</td>
<td>Prior to UIA v3 x</td>
<td>Cardholder to enter Street Number. Leave blank and press <strong>Enter</strong> to bypass entry.</td>
</tr>
<tr>
<td>Enter Street Number</td>
<td>a35ManStre.K3Z</td>
<td>UIA v3.x and above</td>
<td>Cardholder to enter Street Number. Leave blank and press <strong>Enter</strong> to bypass entry.</td>
</tr>
<tr>
<td>Enter PIN</td>
<td>z36EntPin.K3Z</td>
<td>All</td>
<td>Cardholder to enter PIN number.</td>
</tr>
<tr>
<td>Display Message</td>
<td>z411info.K3Z</td>
<td>All</td>
<td>Used to display various messages to the card holder.</td>
</tr>
</tbody>
</table>
**Form Name**
(Screen Image) | **File Name**
(Do Not Change) | **UIA Version** | **Form Description**
--- | --- | --- | ---
Custom Prompt File | CUSTPROMPT.XML | All | Contains the Enter Street Number prompt.
Custom Prompt Signature File | SHF0101.PGZ | All | Contains the digital signature of the custom prompt file. Used to authenticate the changes in CUSTPROMPT.XML

### UTG Automatic Form Loading and UIA Update

The UTG has the ability to push new forms or UIA version updates to all compatible devices. This enables merchants to create custom, seasonal, or promotional forms that can be quickly and easily deployed. Merchants can also update the UIA version on multiple devices using the same feature. The supported file extensions UTG will push for Telium devices include the following:

- .PGN
- .TGZ
- .PGZ
- .OGZ

**Requirement:** UTG 2243 or higher is required to utilize the Form Loading feature.
UTG 2245 or higher is required to use the UIA Update feature.
UIA 3.3 is required for P2PE devices.

To push forms or UIA updates to all compatible devices, complete the following steps:

**Requirement: Telium P2PE Requirement:** UIA updates are generic and do not take P2PE into account. If a UIA update is pushed to a Telium P2PE Device, the TDES090.PGZ file must also be run following the push in order to continue using P2PE on the device. The TDES090.PGZ file is supplied by Ingenico. If you do not have the file, please contact Ingenico.

81. For form changes, create a package of forms using the Ingenico Telium Data Packaging Tool. This file should have a ".TGZ" extension.
82. For UIA updates, you should have a file with an ".OGZ" extension.
83. Copy the ".TGZ" file or the ".OGZ" file(s) to ".\Shift4\UTG2\Update\Forms\DeviceType" where DeviceType represents the type of Telium device, such as "Ingenico iSC250 P2PE."

*For example:* ".\Shift4\UTG2\Update\Forms\Ingenico iSC250 P2PE
Other device types include the following:

- Ingenico Touch iSC250
- Ingenico Touch iSC350
- Ingenico Touch iSC480
- Ingenico iPP320 [U.S.]
- Ingenico iPP350
- Ingenico Touch iSC250 P2PE
- Ingenico Touch iSC350 P2PE
- Ingenico Touch iSC480 P2PE
- iPP320 P2PE
- iPP350 P2PE

**Note:** There should only be one set of forms in the folder. If you have a previous package of forms, make a copy and store in another folder for future use.
84. Create a new text file in the same directory where the package file or UIA version update file is placed and name the file Update.txt. The Update.txt file should not contain any content. It is simply for triggering the update.

85. The UTG will look for an Update.txt file every 30 seconds while idling. When an Update.txt file is present, the UTG will push the package of forms or UIA update to each of the compatible devices connected to the UTG.

86. The devices will display Updating Files Please Wait while the UTG is pushing the package or UIA update to the devices.

87. Once the package of forms or UIA version update has been pushed to all compatible devices, the UTG will reboot all compatible devices.

88. (For Forms Only) When the reboot process is complete, the UTG will verify all the forms have loaded. The message Verifying Forms Please Wait will be displayed on all compatible devices.
   - If any forms are missing, the UTG will display a message on the device indicating which forms are missing. The missing forms must be added before the device can be used.
   - If all of the forms are present, the UTG will display the idle screens on the devices.

89. The UTG will then delete the Update.txt file.

---

**Note:** To prevent problems from downloading forms to too many devices at once, set the **Limit Simultaneous Downloads** in TuneUp on the Devices tab to a lower number. See the UTG Quick Installation Guide for more information.
Using the Ingenico Telium Form Builder

To link the custom prompt to Telium Form Builder, complete the following steps:

90. Click **Tools > Options**.
91. Click **Prompts** in the left pane.
92. Click the ... button on the CUSTPROMPT File line.
93. Browse the directory where you extracted the PIN pad device forms.
94. Select the CUSTPROMPT.XML file and click **Open**.
95. Click **OK** to close the Options window.

To edit the Shift4 template forms in the Telium Form Builder complete the following steps:

96. From the Telium Form Builder menu, select **File > Open** and select the form to edit.
97. Double click the file to be edited.
98. With the form loaded in the Telium Form Builder window, click the field you want to edit.
99. Modify the images, text placement, and button placement as desired.
100. When finished editing, select **File > Save** to save your changes.
101. Load all modified forms on to your device using the instructions above.
Converting a UIA device to RBA

The quickest way to convert a device currently running UIA to RBA is to push the Shift4 RBA package. If the package option is not available, you can push the RBA update manually. Since RBA only supports P2PE implementations, the existing UIA device must already have P2PE enabled in order to update it without returning the device to a key injection facility.

**Requirement:** The device must already have a P2PE key injected in order to update it without sending it back to a key injection facility. If the device is not currently a P2PE device it will not work once converted to RBA.

Converting a P2PE UIA device to RBA via Shift4 Package

To convert a P2PE UIA device to run RBA using the Shift4 .twb package file perform the following steps:

**Requirement:** The UIA device must be running UIA 8 or higher in order to push ".twb" files.

6. Download the Shift4 RBA forms for the device you are planning to update.
7. Modify the forms as needed to match your branding.
8. Add the updated forms to the RBA package. See the *Updating an RBA Package to Utilize Branded Forms* section for more details.
9. Ensure that UTG is still configured for the UIA version of the Ingenico Telium P2PE device.
10. Utilize UTG’s automatic form loading functionality to push the RBA package to the device.
11. After the package has been pushed to the device and the device reboots shut down UTG.
12. Reconfigure UTG TuneUp to utilize the RBA version of the Ingenico Telium device.
13. Start UTG.
Converting a P2PE UIA device to RBA via manual update

To convert a P2PE UIA device to run RBA manually, complete the following steps:

**Note:** This option should only be utilized if the device is running a UIA version prior to UIA 8.

14. Download the Shift4 RBA forms for the device you are planning to update.
15. Ensure that UTG is still configured for the UIA version of the Ingenico Telium P2PE device.
16. Utilize UTG’s automatic form loading functionality to push the RBA ".OGZ" file to the device. The ".OGZ" file can be found in the Manual folder, inside the device forms zip folder downloaded in step 1, as displayed below:

![Image of "OGZ" file in Manual folder]

17. After the RBA ".OGZ" package has been pushed to the device and the device reboots, shut down UTG.
18. Reconfigure UTG TuneUp to utilize the RBA version of the Ingenico Telium device.
19. Start UTG.
20. Utilize UTG’s automatic form loading functionality to push the RBA TDES.PGZ file to the device. The ".PGZ" file is also located in the Manual folder inside the device forms zip folder downloaded in step 1, as displayed below:

![Image of "PGZ" file in Manual folder]

21. The device will reboot after the RBA ".PGZ" package has been pushed.
22. Download the Shift4 RBA forms for the device you are using.
23. Extract the forms zip file to a temporary directory.
24. Modify the forms as needed to match your company’s branding.
25. Create a “.TGZ” forms package using Ingenico Telium Packaging Tool.
26. Utilize UTG’s automatic form loading functionality to push the “.TGZ” forms package file to the device.

Converting a non-P2PE UIA device to RBA

You will need to send your device back to the key injection facility to load the P2PE key and the RBA application.
Configuring Verifone Devices

Configuring Verifone® SC 550

Resetting the Device

To verify the Verifone® SC 550 settings, complete the following steps:

102. Disconnect and then reconnect the power cord to reset the device.
103. If TERMINAL ID displays 19.2, press the yellow CORR button to change the baud to 9600.
104. Press the green OK button.
105. Disconnect and then reconnect the power cord to reset the device again.

Note: When configuring the UTG TuneUp for this device, the Tip 1 option prompts the customer to enter a tip amount manually; the Tip 2 option allows the customer to choose between a preset tip amount, or a manually-entered tip amount.
Other Settings
Verify that the following settings have been applied on the UTG Stub IP to Serial window:

- Data Bits (Byte Size): 7
- Parity: Even
- Stop Bits: 1
- Flow Control: None

Configuring the Verifone® PINpad 1000 Series
The UTG supports two devices in the Verifone® PINpad 1000 series, as shown below. The Verifone® PINpad 1000 (shown on the left) has 10 number buttons, a red Clear button, and blue Enter button. The Verifone® PINpad 1000se (shown on the right) also has 10 number buttons, in addition to three blue function keys, a red “X” (cancel) button, a green arrow (enter) button, and a yellow arrow (clear) button.

Resetting the Device
To reset the Verifone PINpad 1000 or Verifone PINpad 1000se, complete the following steps:

106. Disconnect and reconnect the power cord.
107. While holding down the CLEAR or X button, press 2.
108. When prompted for the password, type 844747746.
109. Press ENTER.

Setting the Baud Rate
110. On the scrolling message, watch for the number to press to open the Baud Rate menu.
111. Press the appropriate number for the Baud Rate menu.
112. Select the Baud Rate:
   • (1) = 1200
   • (2) = 2400
   • (3) = 4800
   • (4) = 9600 (recommended setting)

113. Verify the baud rate entered in the UTG Stub matches the baud rate selected on the Verifone PINpad 1000 device. If the Verifone PINpad 1000 is connected directly to the UTG, set the baud rate to 9600.

Other Settings
Verify that the following settings have been applied on the UTG Stub IP to Serial window:
   • Data Bits (Byte Size): 7
   • Parity: Even
   • Stop Bits: 1
   • Flow Control: None

Configuring Verifone® SC 5000

Resetting the Device
To verify the Verifone® SC 5000 settings, complete the following steps:
114. Disconnect and then reconnect the power cord to reset the device.
115. Use the F1 and F3 arrow buttons to change the options:
   • Baud rate:
     (1) = 19200
(2) = 9600 (recommended setting)
(3) = 4800
(4) = 2400

- Parity:
  (1) = 8 B No PARITY (recommended setting)
  (2) = 7 B Even PARITY

116. Press the **F2 OK** button.

---

**Note:** When configuring the UTG TuneUp for this device, both Tip 1 and Tip 2 options prompt the customer to enter a tip amount manually.

---

**Other Settings**

Verify that the following settings have been applied on the UTG Stub IP to Serial window:

- Data Bits (Byte Size): 8
- Parity: None
- Stop Bits: 1
- Flow Control: None
Configuring the Verifone® MX Series

The UTG supports a number of Verifone® MX series devices. The Verifone® MX 915 and the Verifone® MX 850 offer both keypad and touchpad functionality. The Verifone® MX 870 and the Verifone® MX 870 Contactless (shown with optional field-upgradeable module), offer full touchpad functionality without a keypad.

**Note:** When selecting the Verifone MX 850 or MX 870 device in the UTG TuneUp, select MX 850N or MX 870N.

During installation and configuration, the special keys on the Verifone MX 850 function as follows:

- F3: next item
- F4: next tab
- Enter: select highlighted item
- Clear: backspace
- Cancel: previous screen
Note: You can connect the Verifone MX devices using either a serial (RS232) cable with a green connector, or a USB cable with a blue connector. Ensure the correct cable is used with each initial setting.

<table>
<thead>
<tr>
<th>Verifone FormAgent</th>
<th>Verifone XPI</th>
<th>Supported?</th>
<th>Description of Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.2.0g</td>
<td>NA</td>
<td>No</td>
<td>No known issues</td>
</tr>
<tr>
<td>2.2.0k</td>
<td>NA</td>
<td>Deprecated</td>
<td>No known issues</td>
</tr>
<tr>
<td>2.2.1s</td>
<td>NA</td>
<td>Deprecated</td>
<td>No known issues</td>
</tr>
<tr>
<td>2.2.1t</td>
<td>NA</td>
<td>Deprecated</td>
<td>No known issues</td>
</tr>
<tr>
<td>2.2.1w</td>
<td>NA</td>
<td>Deprecated</td>
<td>No known issues</td>
</tr>
<tr>
<td>2.2.1o</td>
<td>NA</td>
<td>Deprecated</td>
<td>No known issues</td>
</tr>
<tr>
<td>2.3.1q</td>
<td>NA</td>
<td>Yes</td>
<td>Supported if xifm_addmodelprefix is not present or set to 0</td>
</tr>
<tr>
<td>2.3.2p</td>
<td>NA</td>
<td>Yes</td>
<td>No known issues</td>
</tr>
<tr>
<td>2.3.3i</td>
<td>NA</td>
<td>TBD</td>
<td>No known issues</td>
</tr>
<tr>
<td>3.0.0.w</td>
<td>NA</td>
<td>Yes</td>
<td>No known Issues</td>
</tr>
</tbody>
</table>

To find the FormAgent version on the Verifone device, complete the following steps:
1. Verify the UTG is not running.
2. Power cycle the device.
3. Confirm the FormAgent version is displayed on boot up.
Verifying and Loading FormAgent

Verify the latest supported version of FormAgent is installed. If not, obtain the latest supported version from Verifone and install.

117. Download the form files for your specific device:


118. To transfer FormAgent to the device, copy the files to a USB drive.

Note: Connect the device using green-connector RS-232 cable, transfer the files to a USB flash drive, and then to the device through the USB port on the RS-232 cable to ensure the fastest transfer rate. FormAgent may be transferred directly through a USB cable; however, transfer rates will be slower and partial downloads and errors may occur.

119. Reset the device by completing the following steps:

- Using a paperclip or ballpoint pen, press the reset button.
- Type the password supplied in Verifone documentation.
• Select **USB** or **RS232** as appropriate.

120. Load the applications on the device:
• Select the **File Transfer** icon.
• On the RS-232 cable, insert the USB drive into the USB port.
• Select the **USB storage** icon.
• For the initial installation complete the following step:
  o Select **Full** to download the FormAgent files.

121. To return to the previous menu, select the **File Manager** icon.
122. To verify successful application load, select the **Run Application** icon.

**Downloading Verifone MX Tools**

To download Verifone MX Tools click [http://www.shift4.com/downloads/VerifoneMXTools.zip](http://www.shift4.com/downloads/VerifoneMXTools.zip) to download the zip file and extract the files to a temporary directory.

The files will include the following:
• MX Downloader – Verifone’s tool used to push files to Verifone devices
• MX_FormMgr_3.03B – Verifone’s Form Manager tool used to customize forms
• MX_USB Driver – Verifone’s USB driver
• VeriTar – Verifone’s VeriTar application used to create TGZ files

<table>
<thead>
<tr>
<th>Name</th>
<th>Date modified</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX Downloader</td>
<td>12/3/2014 3:36 PM</td>
<td>File folder</td>
</tr>
<tr>
<td>MX_FormMgr_3.03B</td>
<td>7/20/2015 11:18 AM</td>
<td>File folder</td>
</tr>
<tr>
<td>MX_USB Drivers</td>
<td>7/20/2015 11:17 AM</td>
<td>File folder</td>
</tr>
<tr>
<td>VeriTar</td>
<td>7/20/2015 11:19 AM</td>
<td>File folder</td>
</tr>
</tbody>
</table>

**Note:** Verifone Tools are supplied by Verifone. For more information on Verifone Tools contact Verifone.
Configuring the Device

To configure and verify the settings on the Verifone MX series, complete the following steps:

123. On the System screen, select the **Configure** icon.
124. Select the right arrow to advance to additional Configure screens.
125. From the second Configure screen, select the **Editor** icon.
126. Compare and verify the settings listed in the following table:

<table>
<thead>
<tr>
<th>Section</th>
<th>Variable</th>
<th>Function</th>
<th>Action Required</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>[PERM]</td>
<td>go</td>
<td>Startup Verify</td>
<td>Verify</td>
<td>frmAgent.exe</td>
</tr>
<tr>
<td>[REG]</td>
<td>comctype</td>
<td>Comm Type</td>
<td>Set</td>
<td>RS232 or USB</td>
</tr>
<tr>
<td>[REG]</td>
<td>cp</td>
<td>Comm Port</td>
<td>Set</td>
<td>*</td>
</tr>
<tr>
<td>[REG]</td>
<td>bd</td>
<td>Baud Rate</td>
<td>Set</td>
<td>8</td>
</tr>
<tr>
<td>[REG]</td>
<td>prot</td>
<td>Protocol Format</td>
<td>Set</td>
<td>4</td>
</tr>
<tr>
<td>[REG]</td>
<td>KSN</td>
<td>Key Padding (Fs)</td>
<td>Add</td>
<td>1</td>
</tr>
</tbody>
</table>

* If using the Serial Port, set the Comm Port according to the label on the Multi Port Connector. If not using the Serial Port, the Comm Port setting is irrelevant.

**Requirement:** Entering 8 for the Baud Rate sets the rate of the physical device to 115200. You must also configure the Verifone MX series device in UTG TuneUp or UTG Stub TuneUp with a Baud Rate of 115200.

- To advance through the list, press the **green arrow (enter)** button. Press the **F4** button to select the **down (DN)** tab.
- To edit the settings, press the **green arrow (enter)** button. Press the **F3** button to select individual options.

127. Return to System Mode menu and select **File Manager**. Select **Run Application** to restart the application without completely rebooting the device.
UTG Automatic Form Loading and Form Agent Update

If you are using the Shift4 forms, the process for uploading the forms is easy.

**Note:** If you will be customizing your forms, see the *Loading Custom Forms with UTG Automatic Form Loading* section in this document to avoid having to load the forms a second time.

The UTG has the ability to push new forms or FormAgent updates to all compatible devices. Download the .zip file for your device(s) and extract the forms. The supported file extensions that UTG will push for Verifone devices include the following:

- *.TGZ*
- *.TAR*
- *.GZ*.

**Requirement:** UTG 2251 or higher is required to utilize the Form Loading feature.

To push forms or FormAgent updates to all compatible Verifone devices, complete the following steps:

128. Extract the Shift4 forms from the downloaded .zip file. They should have a “.TGZ” extension. The file name must be 20 characters or less.

**Note:** Form Agent updates will also have a “.TGZ” extension.

129. Copy the “.TGZ” file to \Shift4\UTG2\Update\Forms\DeviceType where DeviceType represents the type of Verifone device, such as “Verifone MX 850.”

*For example:* \Shift4\UTG2\Update\Forms\Verifone MX 850
130. Create a new text file in the same directory where the package file is placed and name the file Update.txt. The Update.txt file should not contain any content. It is simply for triggering the update.

131. The UTG will look for an Update.txt file every 30 seconds while idling. When an Update.txt file is present, the UTG will push the package of forms or FormAgent update to each of the compatible devices connected to the UTG.

132. The devices will display Updating Files Please Wait while the UTG is pushing the package or Form Agent update to the devices.

133. Once the package of forms or FormAgent update has been pushed to all compatible devices, the UTG will reboot all compatible devices.

134. When the reboot process is complete, the UTG will verify all the forms have loaded. The message Verifying Forms Please Wait will be displayed on all compatible devices.

- If any forms are missing, the UTG will display a message on the device indicating which forms are missing. The missing forms must be added to the “.TGZ” file before the device can be used.
- If all of the forms are present, the UTG will display the idle screens on the devices.

135. The UTG will then delete the Update.txt file.

**Editing Shift4 Template Forms for Verifone Devices**

Several of the UTG-compatible devices include editable forms. This allows merchants to add specific wording and logos on individual forms or in the background of every form. Follow the instructions provided for the applicable device manufacturer.

Various graphics software programs may be used to create images such as buttons or backgrounds for use in the forms, but modifying the forms must be done using the form manager application. The form
manager application generates forms in the necessary ".FRM" format which is not available on other graphics software.

---

**WARNING!** Altering the layout of the form is permitted, but the Control ID must not be changed. It is also important not to add or delete buttons on the form.

---

<table>
<thead>
<tr>
<th>Form Number</th>
<th>Form Name (Screen Image)</th>
<th>File Name (DO NOT CHANGE)</th>
<th>Form Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>main1</td>
<td>MainScreen (Main Screen)</td>
<td>main1</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>idle1</td>
<td>IdleScreen1 (IDLE SCREEN 1)</td>
<td>idle1</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>idle2</td>
<td>IdleScreen2 (IDLE SCREEN 2)</td>
<td>idle2</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>idle3</td>
<td>IdleScreen3 (IDLE SCREEN 3)</td>
<td>idle3</td>
<td>When the system is idle, it rotates through the first four forms to prevent screen burnout.</td>
</tr>
<tr>
<td>scr05</td>
<td>PleaseWait (Please Wait...)</td>
<td>scr05</td>
<td>The customer is waiting for system to process.</td>
</tr>
<tr>
<td>scr06 (Used with customer tip entry)</td>
<td>FBAmount</td>
<td>scr06</td>
<td>Ticket amount, tip amount, and total amount will be shown. The customer is to accept the amount, change the tip amount, or cancel the transaction</td>
</tr>
<tr>
<td>scr07 (Used without customer tip entry)</td>
<td>AmountOK</td>
<td>scr07</td>
<td>The total amount will be shown. The customer is to accept the amount, or cancel the transaction.</td>
</tr>
<tr>
<td>Form Number</td>
<td>Form Name (Screen Image)</td>
<td>File Name (DO NOT CHANGE)</td>
<td>Form Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------</td>
<td>---------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>scr08</td>
<td>SelectCardType (Please select the Card Type)</td>
<td>scr08</td>
<td>The customer is to select the card type.</td>
</tr>
<tr>
<td>scr09</td>
<td>SlideCard (PLEASE SWIPE CARD)</td>
<td>scr09</td>
<td>The customer is to swipe card.</td>
</tr>
<tr>
<td>scr10</td>
<td>PleaseResign (Please Sign Again)</td>
<td>scr10</td>
<td>The system is unable to read the signature. The customer must re-sign the signature.</td>
</tr>
<tr>
<td>scr11</td>
<td>SignBelow (Please Sign Below)</td>
<td>scr11</td>
<td>The transaction was approved. The customer is to enter their signature, then click <strong>Accept</strong>. Click <strong>Clear</strong> to reset signature field. Click <strong>Cancel</strong> to exit screen without signature.</td>
</tr>
<tr>
<td>scr12</td>
<td>Approved (APPROVED)</td>
<td>scr12</td>
<td>The transaction was approved.</td>
</tr>
<tr>
<td>scr13</td>
<td>Declined (DECLINED)</td>
<td>scr13</td>
<td>The transaction was declined.</td>
</tr>
<tr>
<td>scr14</td>
<td>Referral (Your transaction was not approved. Please see cashier.)</td>
<td>scr14</td>
<td>The merchant is required to call for voice authorization.</td>
</tr>
<tr>
<td>scr15</td>
<td>NotProc (Unable to process transaction. Your card has not been charged.)</td>
<td>scr15</td>
<td>Shift4 was unable to process the transaction. The transaction did not go through and the customer’s credit card was not charged.</td>
</tr>
<tr>
<td>scr16</td>
<td>ApprovedPleaseSign (Your transaction was approved. Please sign draft.)</td>
<td>scr16</td>
<td>The transaction was approved. The customer is to sign the receipt draft.</td>
</tr>
<tr>
<td>scr17</td>
<td>EnterAmount (Used with customer tip entry)</td>
<td>scr17</td>
<td>Allows customer to enter tip amount.</td>
</tr>
<tr>
<td>SCR18</td>
<td>ListItem</td>
<td>scr18</td>
<td>Allows the customer to see what was purchased/scanned by the merchant POS.</td>
</tr>
<tr>
<td>Form Number</td>
<td>Form Name (Screen Image)</td>
<td>File Name (DO NOT CHANGE)</td>
<td>Form Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------</td>
<td>---------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>SCR30</td>
<td>SlideCard (Please Swipe Card:)</td>
<td>scr30</td>
<td>The customer is to swipe their card or press the manual button to manually enter the card number.</td>
</tr>
<tr>
<td>SCR31</td>
<td>EnterCardNumber (Enter Card Number:)</td>
<td>scr31</td>
<td>The customer is to manually enter their card number.</td>
</tr>
<tr>
<td>SCR32</td>
<td>EnterExpirationDate (Enter Expiration Date:)</td>
<td>scr32</td>
<td>The customer is to enter the expiration date associated with the card.</td>
</tr>
<tr>
<td>SCR33</td>
<td>EnterSecurityCode (Enter Security Code:)</td>
<td>scr33</td>
<td>The customer is to enter the CVV/Security Code associated with the card for CVV2 verification.</td>
</tr>
<tr>
<td>SCR34</td>
<td>Note: This screen will read “ZIP Code” on the MX 850. The MX 850 will have a button below the screen and not in the display where the cardholder may select “Non-US Postal Code.” For the MX 870, the text will read: (Enter Postal/ZIP Code:)</td>
<td>scr34</td>
<td>The customer is to enter the ZIP or Postal Code associated with the credit card account for AVS verification.</td>
</tr>
<tr>
<td>SCR35</td>
<td>EnterStreetNumber</td>
<td>scr35</td>
<td>The customer is to enter the street number portion of their address.</td>
</tr>
<tr>
<td>SCR36</td>
<td>EnterPostalCode (Postal Code:)</td>
<td>scr36</td>
<td>The customer is to enter the non-U.S. Postal Code associated with the credit card account for AVS verification. On this screen, alpha numeric entry is allowed.</td>
</tr>
<tr>
<td>SCR40</td>
<td>SwipeAhead</td>
<td>scr40</td>
<td>This screen displays line items with ability for the customer to swipe or use manual entry.</td>
</tr>
<tr>
<td>SCR41</td>
<td>Info</td>
<td>scr41</td>
<td>This screen displays informational messages to the user, such as 'Field Required' or 'Invalid Zip.'</td>
</tr>
<tr>
<td>Form Number</td>
<td>Form Name (Screen Image)</td>
<td>File Name (DO NOT CHANGE)</td>
<td>Form Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------</td>
<td>---------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>SCR50</td>
<td>PromptForConfirmation</td>
<td>scr50</td>
<td>This is used for customized prompting, such as ‘Is this email address correct?’ or legal terms.</td>
</tr>
<tr>
<td>SCR51</td>
<td>SSN</td>
<td>scr51</td>
<td>This prompts the user for their Social Security Number for Private Label Quick Credit or Account Lookup.</td>
</tr>
<tr>
<td>SCR52</td>
<td>Date of Birth prompt</td>
<td>scr52</td>
<td>This prompts the user for date of birth when applying for a private label card.</td>
</tr>
<tr>
<td>SCR53</td>
<td>Annual Income prompt</td>
<td>scr53</td>
<td>This prompts the user for their annual income when applying for a private label card.</td>
</tr>
<tr>
<td>SCR54</td>
<td>Terms and Conditions Signature prompt</td>
<td>scr54</td>
<td>This prompts the user for their signature as agreement to the terms and conditions of the private label application.</td>
</tr>
<tr>
<td>SCR55</td>
<td>Terms and Conditions prompt</td>
<td>scr55</td>
<td>This displays the terms and conditions of the private label application.</td>
</tr>
<tr>
<td>SCR56</td>
<td>PL Application Decline prompt</td>
<td>scr56</td>
<td>This is displayed when a PL credit application is declined by the processor.</td>
</tr>
<tr>
<td>915_FA_PINE</td>
<td>PIN Entry</td>
<td>915_FA_PINE</td>
<td>This is for the MX 915 only, and Prompts the user for PIN entry.</td>
</tr>
<tr>
<td>925_FA_PINE</td>
<td>PIN Entry</td>
<td>925_FA_PINE</td>
<td>This is for the MX 925 only and Prompts the user for PIN entry.</td>
</tr>
</tbody>
</table>
Configuring Buttons for Forms

When setting up forms, it is important to consistently use the same Control ID for buttons of the same type of functionality.

Follow the table guidelines below for form button Control ID settings.

- Enter, Clear, and Cancel button configurations

<table>
<thead>
<tr>
<th>Button Configuration Requirement</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make all Enter buttons the same button</td>
<td>Control ID=1</td>
</tr>
<tr>
<td>Make all Clear buttons the same button</td>
<td>Control ID=3</td>
</tr>
<tr>
<td>Make all Cancel buttons the same button</td>
<td>Control ID=2</td>
</tr>
</tbody>
</table>
- Other button configurations

<table>
<thead>
<tr>
<th>Button Description</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Tip</td>
<td>Control ID=4</td>
</tr>
<tr>
<td>Credit/Gift Card</td>
<td>Control ID=1 (Enter)</td>
</tr>
<tr>
<td>Debit Card</td>
<td>Control ID=5</td>
</tr>
<tr>
<td>Amount OK</td>
<td>Control ID=1 (Enter)</td>
</tr>
<tr>
<td>Accept</td>
<td>Control ID=1 (Enter)</td>
</tr>
<tr>
<td>YES</td>
<td>Control ID=1 (Enter)</td>
</tr>
<tr>
<td>NO</td>
<td>Control ID=6</td>
</tr>
<tr>
<td>ManualCard</td>
<td>Control ID=1 (Enter)</td>
</tr>
<tr>
<td>Non-U.S. Postal</td>
<td>Control ID=7</td>
</tr>
</tbody>
</table>

Using Graphics Software

Any text displayed in black when viewing the form in the Form Designer can be modified in any graphics editor. To edit the Shift4 template forms in your graphics editor, complete the following steps:

136. In your graphics software, open the *.bmp file of the form to be edited.

137. Edit the form according to device constraints listed in the following table:

<table>
<thead>
<tr>
<th>Verifone Device Form Constraints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Devices</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>MX 850</td>
</tr>
<tr>
<td>MX 870</td>
</tr>
<tr>
<td>MX 915</td>
</tr>
<tr>
<td>MX 925</td>
</tr>
</tbody>
</table>
WARNING! Do not add color to forms used on black and white devices. Color forms will not run on black and white devices.

Loading Custom Forms With UTG Automatic Form Loading

The UTG has the ability to push new forms to all compatible devices. This enables merchants to create custom, seasonal, or promotional forms that can be quickly and easily deployed. For Verifone MX 900 Series devices, verify you are using the latest supported version of the Form Manager tool. Download the .zip file for your device(s) and extract the forms.

**Requirement:** UTG 2251 or higher is required to utilize the Form Loading feature.

To push forms to the Verifone MX Series devices, complete the following steps:

138. You will need to create a package of forms using the MX Form Manager (refer to Verifone’s instructions for how to use Form Manager). This file should have a “.TGZ” extension and the file name must be 20 characters or less.

139. Copy the “.TGZ” file to `...\Shift4\UTG2\Update\Forms\DeviceType`, where DeviceType represents the type of Verifone device, such as “Verifone MX 850.”

140. Create a new text file in the same directory where the package file is placed and name the file Update.txt. The Update.txt file should not contain any content. It is simply for triggering the update.

141. The UTG will look for an Update.txt file every 30 seconds while idling. When an Update.txt file is present, the UTG will push the package of forms to each of the compatible devices connected to the UTG.

142. The devices will display Updating Files Please Wait while the UTG is pushing the package to the devices.

143. Once the package of forms has been pushed to all compatible devices, the UTG will reboot all compatible devices.
144. When the reboot process is complete, the UTG will verify all the forms have loaded. The message Verifying Forms Please Wait will be displayed on all compatible devices.
   - If any forms are missing, the UTG will display a message on the device indicating which forms are missing. The missing forms must be added before the device can be used.
   - If all of the forms are present, the UTG will display the idle screens on the devices.
145. The UTG will then delete the Update.txt file.

---

**Note:** There should only be one set of forms in the folder. If you have a previous package of forms, make a copy and store in another folder for future use.
Appendix A

The following table contains a list of deprecated devices with supported features.

<table>
<thead>
<tr>
<th>Device</th>
<th>Keypad</th>
<th>US Debit</th>
<th>CAN Debit</th>
<th>MSR</th>
<th>Touch</th>
<th>SigCap</th>
<th>Color</th>
<th>Form Loading</th>
<th>MCE</th>
<th>LID</th>
<th>Contactless/NFC</th>
<th>T&amp;P (Google Wallet)</th>
<th>CTP</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID TECH SecureHead</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ingenico 3070</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ingenico i6550</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ingenico i6780</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Verifone® SC 550</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Verifone® PINpad 1000</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Verifone® PINpad 1000SE</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Verifone® SC 5000</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Verifone® MX 850</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Verifone® MX 870</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

MSR – Magnetic Swipe Reader

SigCap – Signature Capture: The process of electronically capturing the cardholder's signature

MCE – Manual Card Entry: Allows a cardholder to enter card information in a card-present transaction when the card cannot be read by the PIN Pad

LID – Line Item Detail: Displays line item details on the device

T&P – Google Wallet Tap & Pay

CTP – Confirmation Text Prompting
Appendix B – Device Maintenance

The UTG Stand Alone contains a Device Maintenance screen that provides a number of functions for merchants using external devices, such as PIN pads.

To get to the Device Maintenance screen, complete the following steps:

6. In UTG Stand Alone, right click anywhere in the main Stand Alone page.
7. Select Device Maintenance.

The Device Maintenance screen displays any devices that have been configured in UTG and a number of buttons. A description for the use of each button is provided in the table below.

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select All</td>
<td>Selects all displayed devices.</td>
</tr>
<tr>
<td>De-select All</td>
<td>De-selects all displayed devices.</td>
</tr>
<tr>
<td>Key Exchange</td>
<td>Used to resync an Ingenico iPP320 (CAN) device. See the <em>iPP320 Interac Debit Key Exchange</em> section for more information.</td>
</tr>
<tr>
<td>Check Update(s)</td>
<td>Checks the version of selected devices against the version in DOLLARS ON THE NET and downloads an update if needed.</td>
</tr>
<tr>
<td>Button Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Download Now</td>
<td>Used to download device settings configured in DOLLARS ON THE NET or supplied directly from processors as needed.</td>
</tr>
<tr>
<td>Apply Prompts</td>
<td>Used to push the corrected MAC values to selected devices. See the Ingenico iPP320 CAN MAC Values section for more information.</td>
</tr>
<tr>
<td>Verify Forms</td>
<td>Verifies that no Shift4 forms are missing for selected devices.</td>
</tr>
<tr>
<td>Push Forms</td>
<td>Can be used to manually push forms to all similar devices that are selected on the Device Maintenance screen. See the UTG Automatic Form Loading and FormAgent/XPI Update section for more information on both options.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels Device Maintenance screen and returns to the UTG Stand Alone screen.</td>
</tr>
</tbody>
</table>